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Introduccion

iBienvenidos a Rebelle 3!

Rebelle es una aplicacion de pintura Unica que le permite crear obras de arte realistas de las
medios humedos y secos, con simulacidon impresionante y dindmica de flujo de fluidos, de la
mezcla de color, difusidon himeda y del secado. Rebelle imita convincentemente la forma en
gue los medios naturales interactdan con el lienzo y con él mismo. Los usuarios pueden
pintar, manchar, mojar los colores secos, soplar pintura himeda sobre el lienzo, inclinar el
papel para crear gotas de agua y crear incontables efectos fantdsticos de acuarela.

Hemos disefiado Rebelle para los artistas CG asi como para los pintores tradicionales que
guieren explorar y ampliar su repertorio artistico, utilizando la ultima tecnologia digital
innovadora de la pintura.

Rebelle 3 une tradicién y tecnologia con un enfoque original. Los papeles ultra realistas, las
imitaciones de papeles reales y lienzos con bordes cortados o barbas ya no son solo cosa del
mundo material. A partir de ahora, los artistas pueden utilizarlos digitalmente también.
Conservar el blanco del papel o el color de la pintura de fondo en su computadora se puede
hacer exactamente de la misma manera que si se aplicara un fluido de enmascaramiento
utilizado durante siglos solo por artistas tradicionales. Rebelle 3 integra 'DropEngine' - un
nuevo sistema de simulacion que permite recrear el comportamiento de las gotas de
pintura. Las gotas ahora responden de forma realista a la estructura del papel, de los
esténciles y selecciones. Un concepto inventivo de las herramientas Regla y Perspectiva es
una gran mejora apreciada no solo por los novicios, sino también por todos los artistas que
buscan precisién en sus pinturas.

En este manual encontrara informacion general sobre todos los detalles que necesita saber
para un uso de este software. Hemos preparado las explicaciones de sus caracteristicas,
indicios Utiles y antecedentes técnicos de Rebelle para ustedes.

iGracias por comprar Rebelle, espero que pase gran tiempo con la pintura!

Peter Blaskovic
Creador de Rebelle
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Empezamos

Instalar y Registrar Rebelle

Descargar & Instalar

Después de comprar Rebelle, sera redirigido a una pdgina donde ingrese su contrasefia Unica
para el software Rebelle. Esta contrasefia servira para registrar su licencia de Rebelle y
sustituird una clave de registro. También recibira un correo electrénico con un enlace para
descargar.

Usuarios de Mac OS X
Descarga un archivo .dmg del enlace que aparece en un correo electrénico. Localice el

archivo de instalacién de Rebelle llamado "Rebelle 3.dmg". Haga doble clic en el archivo de
instalacion para completar la instalacion.

Usuarios de Windows

Descarga un archivo .exe para el sistema 32 o 64-bit del enlace que aparece en un correo
electrdnico. Localice el archivo de instalacion de Rebelle llamado "Rebelle 3.exe". Haga doble
clic en el archivo de instalacidn .exe para completar la instalacion.

Registrar

Introduzca su correo electrénico y contrasefia Unica.
Por favor compruebe si estd conectado a Internet se requiere la conexion a Internet para la
activacion para comprobar los datos de registro.

Iniciar la Aplicacién

Verd un “Intro Tutorial” durante el primer inicio de la aplicacién o después de cada
actualizacidn a la versién mds reciente. Este tutorial le guiara a través de las herramientas
mas esenciales de Rebelle. Puede abrir este “Intro Tutorial” desde Menu -> Ayuda (Menu ->
Help) en cualquier momento.

Requisitos del Sistema

Minimos: Intel i5 o equivalente AMD procesador, 4GB de RAM, espacio de disco duro de
200MB, tarjeta grafica Open GL con 1GB RAM, Windows 7 (64-bit o 32-bit) o Mac OS X
10.11.

Recomendados: Intel i7 0 equivalente AMD procesador, 8GB de RAM, espacio de disco duro
de 200MB, tarjeta grafica Open GL con 2GB RAM, Windows 7, 8, 10 64-bit o Mac OS X 10.12
0 mas nuevo, tableta grafica compatible con Wacom o Surface.
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Soporte de Tableta

Cuando Rebelle se inicie por primera vez se le pedira que seleccione el dispositivo de tableta
preferido: compatible con Wacom o compatible con Microsoft Ink. Puede cambiar las
opciones de tableta en cualquier momento en Preferencias -> Tablet.

Idiomas

Rebelle esta disponible en diferentes idiomas. Puede seleccionar el idioma de la interfaz de
Rebelle a través del menu Ayuda -> Idioma (Help -> Language). Tiene que reiniciar Rebelle
para aplicar estos cambios.

Obtener Soporte para Rebelle

Si necesita ayuda para utilizar Rebelle en primer lugar consulte este manual incluido. Hemos
intentado hacerlo facil para leer y lleno de informacién que necesita saber.

Le invitamos a enviarnos un correo electronico a support@escapemotions.com si usted tiene

cualquier pregunta, problema técnico con Rebelle o le gustaria simplemente para
saludarnos.

Antes de hacer preguntas por favor visite el foro de Escape Motions Comunidad
escapemotions.com/community en primer lugar. Si la respuesta no esta ahi por favor agrega

la configuracién de su equipo a su correo electréonico (Windows / Mac OS, 32 / 64 bits del
sistema operativo, procesador, tarjeta grafica, memoria). Esto nos ayudard a proporcionar
respuestas mucho mas rapido.

Comunidad

Le invitamos a visitar la Comunidad de Escape Motions donde puede participar en la
discusion sobre el software, obtener consejos y trucos, compartir sus comentarios, crear su
propio portafolio, publicar en Galeria o descargar recursos.

Para iniciar sesién en la Comunidad, use su direccion de correo electrénico y su contrasena
para Rebelle 3.

Sigamos en contacto en nuestros canales sociales también - haga clic en cualquier icono y
visitar nuestras paginas en Facebook, Twitter, Pinterest, Google+, Tumblr, YouTube,
DeviantArt y Behance.

f{w]pf3|tP.]%]se
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Interfaz de Rebelle

MmeAad @<€<Aaqd

Pressure

1 - Barra de Menu (Menu Bar)

2 — Panel de Herramientas (Tools Panel)

3 — Panel de Propiedades (Properties Panel)

4 — Panel de Creador de Pinceles (Brush Creator Panel)
5 — Panel de Navegador (Navigator Panel)

6 — Panel de Color (Color Panel)

7 — Panel de Conjunto de Colores (Color Set Panel)
8 — Panel de Capas (Layers Panel)

9 — Panel de Vista Previa

10 — Panel de Referencia

11 — Panel de Regla / Perspectiva

12 — Panel de Inclinacidén (Tilt Panel)

13 — Panel de Esténciles (Stencils Panel)

14 — Panel de Ajustes Visuales

SUGERENCIA: Todos los paneles son acoplables - es posible modificar, cambiar la posicion y
ajustar la anchura de los paneles. Los paneles ocultan mientras que se pinta en el lienzo
detrds de ellos.



Puede cambiar la interfaz de Rebelle de acuerdo a sus necesidades. Abajo estan los ejemplos
de disefio de interfaz de usuario:

1. Interfaz predeterminada con el 2. Panel de Herramientas y Propiedades en
Panel de Inclinacion no acoplado. modo vertical en el lado izquierdo, los otros
paneles son fusionados en el lado derecho.

4. Paneles de Herramientas, Propiedades y
Conjunto de Colores en modo vertical son
fusionados en el lado izquierdo con el Panel de
Color no acoplado.

3. Paneles de Herramientas y Propiedades en
modo horizontal en la parte superior, los otros
paneles son fusionados en el lado izquierdo.

SUGERENCIA: Puede guardar disefios personalizados de la interfaz de Rebelle a través del
menu Ventana -> Exportar Disefio (Window -> Export Layout). Para abrir el disefio
previamente guardado en Rebelde, seleccione "Importar Disefio" en el menu Ventana.

Aprenda como personalizar la interfaz de Rebelle 3 en este tutorial: Ul Customization.



https://youtu.be/TLgAJE0VhUE

Panel de Herramientas

- Pinceles: Acuarela, Acrilico, Pastel, Lapiz, Pluma,
Rotulador y Aerdgrafo.

- Borrador

- Herramientas: Fusionar, Manchar, Mojar, Secar,
Soplar, Escoger Color, Transformar, Seleccion y Tamafio
del Lienzo.

- Deshacer / Rehacer

~ Contraer Panel - Contraiga el Panel de Herramientas. Este botdn esta presente en todos
los paneles de la interfaz de Rebelle.

— Menu de Panel de Herramientas: Seleccione para cerrar el panel. Es posible mostrar el
panel de nuevo desde el Menu de Ventana (Window menu).

La siguiente imagen muestra el comportamiento de cada técnica de pintura:

Watercolor Acrylic Pastel

Pencil Ink Pen Marker Airbrush

A\

|\

(/) Rebolle

/ Fusionar - Herramienta para fusionar los colores o marcas de pincel.
» Manchar - Herramienta para manchar los colores o marcas de pincel.

0 Mojar - Seleccione la herramienta de mojar para afadir agua a una parte especifica del
lienzo.
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Secar - Seleccione la herramienta de secar para eliminar agua de una parte especifica del
lienzo.
= Soplar - Seleccione la herramienta para soplar los colores himedos.
4
7" Escoger Color - Seleccione la herramienta para escoger el color del lienzo.
X Transformar - Mueve, escale, rote o voltee la capa seleccionada.

... Seleccidn - Seleccione y marque dareas del lienzo para realizar operaciones en esta area
seleccionada.

[m Tamaiio del Lienzo - Seleccione esta herramienta para cambiar el tamafio, escalar o
recortar el lienzo.

D Deshacer - Deshace la Gltima operacion de pintura que ha realizada.

C Rehacer - Rehace la Ultima operacion de deshacer.
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Panel de Propiedades

Este panel contiene ajustes de herramientas, pinceles preestablecidos y grupos de pinceles.
Todos los pinceles, borrador, asi como herramienta Fusionar, Manchar, Mojar y Secar tienen
varios pinceles preestablecidos disponibles. Puede crear sus propios pinceles usando el
panel Creador de Pinceles (Brush Creator). Muestre u oculte el panel Creador de Pinceles

—

utilizando el botén == en la esquina inferior izquierda del panel Propiedades o en el menu
Ventana.

Haga clic en el botén @ para duplicar el pincel preestablecido seleccionado o el botén B
para eliminar el pincel preestablecido seleccionado.

Puede cambiar el orden de los pinceles mediante arrastrar y soltar o cambiar el nombre del
pincel seleccionado haciendo doble clic en él, escribiendo un nuevo nombre y pulsando
Enter.

Mas informacion acerca de cédmo crear pinceles personalizados se puede encontrar en la
seccion Panel de Creador de Pinceles.

=— Menu de Panel de Propiedades:
- Icono - Seleccione qué pardmetros se mostraran en la vista previa del icono del pincel:
Imagen, Trazo o Nombre. Vea ejemplos de varios iconos de pincel:

Size

Pressure

Loading

Pincel - imagen, trazo, nombre Pincel - imagen y nombre Pincel - trazo y nombre Pincel - solo nombre
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- Restablecer Propiedades - Restablezca propiedades de la herramienta actual a los valores
predeterminados.

- Duplicar Pincel Preestablecido - Duplique el pincel seleccionado.

- Eliminar Pincel Preestablecido - Elimine el pincel seleccionado.

- Copiar Pincel Preestablecido - Copie el preajuste de pincel seleccionado en el portapapeles
(atajo Ctrl + Shift + C).

- Pegar Pincel Preestablecido - Pegue el preajuste de pincel seleccionado desde el
portapapeles (atajo Ctrl + Shift + V).

- Importar Pincel Preestablecido - Importe pincel del archivo de imagen.

- Exportar Pincel Preestablecido - Exporte pincel desde Rebelle.

- ARadir Grupo - Afiada un nuevo grupo de pincel a la herramienta actual.

- Eliminar Grupo - Elimine el grupo seleccionado de pincel de la herramienta actual.

- Cerrar - Cierre el panel. Es posible mostrar el panel de nuevo desde el menu Ventana
(Window Menu).

SUGERENCIA: Puede copiar y pegar facilmente el pincel o agregar y eliminar grupos para la
herramienta actual también con el botdn derecho del ratén - haga clic directamente en el
panel Propiedades.

Propiedades de Herramienta Acuarela

2lee 2" Los parametros son predeterminados para simular el

Pressure

comportamiento de los acuarelas. Para efectos

Loading

diferentes, los parametros se pueden ajustar de
Wakter

acuerdo a sus necesidades:

Tamaiio - Ajuste el tamafio del pincel (1-100).

Presion - Ajuste la presion del pincel (1-100). Si se utiliza
la presién del lapiz de la tableta grafica, puede ajustar la
sensibilidad a la presién.

Cargando - Ajuste la cantidad de color cargado al pincel
(1-100). - Influya el espesor del pincel.

Agua - Ajuste la cantidad de agua (1-100). Cuanta mas
agua esta aplicada en el pincel, mas realista esta el

efecto de la acuarela que se puede conseguir.

SUGERENCIA 1: Puede cambiar el tamafio del pincel directamente en el lienzo utilizando el
atajo Ctrl o Cmd + clic con boton izquierdo del raton y arrastrar. Arrastre hacia la izquierda
para disminuir el tamano del pincel, a la derecha para aumentar el tamanio del pincel.
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SUGERENCIA 2: Puede establecer una sensibilidad de presion de pluma mds suave o mds
firme en Preferencias -> Tableta (Preferences -> Tablet). Puede cambiar la presion
individualmente para cada herramienta en su panel de Propiedades con el deslizador de
Presion.

SUGERENCIA 3: Ajuste "Agua" a 1 para humedecer la capa ligeramente, o ajuste "Agua” a
valores superiores para poner mds agua a la parte especifica del lienzo. No es necesario
utilizar mucha agua para obtener efectos bonitos de acuarela.

Obtenga mas informaciones sobre los controles deslizantes de acuarela en este tutorial:
Watercolor Property Sliders.

‘ 7 . . .
# Pincel Permanente (Permanent Brush) - Cuando estd activado, el pincel mantiene su
color todo el tiempo. Con el control deslizante "Cargando" se puede establecer la cantidad
de color que desea cargar al pincel.

&
£ Pincel Normal (Normal Brush) - El modo normal del pincel. La cantidad de pigmento
cargado al pincel depende del control deslizante "Cargando".

£ Pincel Sucio (Dirty Brush) - El pincel sucio nunca se va a limpiar a si mismo y permanece
coloreado por el ultimo color cargado en la misma.

O Pincel Limpio (Clean Brush) - El pincel limpio no esta cargado con cualquier pigmento en
si mismo. Cuando esta activado, el pincel se re-colorea por cualquier color que pasa a través
del lienzo.

o Pincel Borrador - Utilice cada pencil como un borrador. Esta opcidn esta disponible para
acuarela, acrilico, pastel, l1apiz, pluma de tinta, marcador y herramienta de aerégrafo.

Grupos de Pinceles - Se pueden crear nuevos grupos de pinceles para la herramienta
seleccionada desde el menu del panel de Propiedades -> Afiadir grupo o haciendo clic con el
botdn derecho del raton.

Cambie el nombre del grupo de pinceles haciendo doble clic en su nombre, ingrese el nuevo
nombre del grupo de pinceles y presione Enter.

Oculte el grupo de pinceles con un clic en botdén izquierdo del ratdn en la barra de titulo del
grupo.

Se puede eliminar el grupo de pinceles seleccionado desde el menu del panel Propiedades -
> Eliminar Gupo o con el botén derecho del mouse o haciendo clic con el botén derecho del
raton.

NOTA: Se pueden crear grupos para pinceles, asi como para esténciles y texturas de lienzo.
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https://youtu.be/RwCi1Z0G6kA

SUGERENCIA: Se puede mover el preajuste de pincel seleccionado de un grupo de pinceles
a un otro usando arrastrar y soltar.

Propiedades de Herramienta Acrilico

Size Color de acrilico es el medio himedo utilizado en su

Pressure

mayoria con pinceles planos. Puede ajustar los

Loading

parametros de color de acuerdo a sus necesidades:

Tamano - Ajuste el tamano del pincel (1-100).

Presion - Ajuste la presién del pincel (1-100) — Influya el
espesor del pincel.

Cargando - Ajuste la cantidad de color cargado al pincel
(1-100).

Agua - Ajuste la cantidad de agua en color (1-100).

SUGERENCIA: Ajuste "Cargando" al valor mds bajo y
obtendrd un pincel fino. Establezca los valores mds altos

y obtendrda el pincel espeso con una gran cantidad de
masa.

Obtenga mds informaciones sobre la herramienta acrilico en este tutorial: Acrylics.

& . . . . .
# Pincel Permanente (Permanent Brush) - Cuando esta activado, el pincel mantiene su
color todo el tiempo. Con el control deslizante "Cargando" se puede establecer la cantidad
de color que desea cargar al pincel:

Cargando al ‘1’ Cargando al 25’ Cargando al '50’ Cargando al ‘100’

&
£ Pincel Normal (Normal Brush) - El modo normal del pincel. La cantidad de pigmento
cargado al pincel depende del control deslizante "Cargando":
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https://youtu.be/Da--zdT1urU

Cargando al ‘1’ Cargando al 25’ Cargando al '50’ Cargando al ‘100’

£ Pincel Sucio (Dirty Brush) - El pincel sucio nunca se va a limpiar a si mismo y permanece
coloreado por el Ultimo color cargado en la misma:

1. trazo: el pincel pasa de color naranja a azul.
2. trazo: el pincel queda coloreado por el Gltimo color
cargado en la misma (en nuestro caso es color azul).

O Pincel Limpio (Clean Brush) - El pincel limpio no esté cargado con cualquier pigmento en
si mismo. Cuando esta activado, el pincel se re-colorea por cualquier color que pasa a través
del lienzo:

1. trazo: el pincel pasa de color naranja a azul. Cuando se
suelta, el pincel se limpia.

2. trazo: el pincel limpia pinta de nuevo desde el naranja al
color azul.

SUGERENCIA: Se puede ajustar los atajos del teclado personalisados para Pincel Permanente,
Normal, Sucio y Limpio en panel de Preferencias. Cuando se ajustan atajos en seccion
Herramientas (Tools), el atajo activard el pincel particular. Cuando se ajustan los atajos en
seccion Herramientas - mantener (Tools - hold) el pincel se activard sélo cuando el atajo estd
mantenido.

Obtenga mds informaciones sobre el pincel permanente, normal, sucio y limpio en este
tutorial: Brush Modes.
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https://youtu.be/yf3KNyO01iY

Establezca la visibilidad de la estructura con el control deslizante Esperor de Impasto (0-10)
en el panel Ajustes Visuales (accesible desde panel Capas o menu Ventana -> Ajustes
Visuales). Vea el siguiente ejemplo:

Impasto Depth

Propiedades de Herramienta Pastel

Pastel es un medio seco en la forma de un palo, que
consiste en pigmento en polvo puro y un aglutinante.
Puede ajustar los parametros de acuerdo a sus
necesidades:

Tamaiio - Ajuste el tamafio del pastel (1-100).
Presion - Ajuste la presion del pastel (1-100) — Influya el
espesor del pastel.

Obtenga mds informaciones sobre la herramienta pastel en este tutorial: Pastel.
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https://youtu.be/bQGgZSeKAck

Propiedades de Herramienta Lapiz

Lapiz de color es un medio artistico construida de un
nucleo estrecho y pigmentada encerrado en una caja
cilindrica de madera. Puede ajustar los pardmetros de
acuerdo a sus necesidades:

Tamaiio - Ajuste el tamafio del lapiz (1-100).
Presidn - Ajuste la presion del lapiz (1-100) — Influya el
espesor del lapiz.

Propiedades de Herramienta Pluma

La tinta es un liquido que contiene pigmentos o
colorantes. Puede ajustar los parametros de acuerdo a
sus necesidades:

Tamaiio - Ajuste el tamafio de la pluma (1-100).
Presion - Ajuste el espesor de la pluma (1-100).
Agua - Ajuste la cantidad de agua en color (1-100).

Obtenga mds informaciones sobre la herramienta pluma en este tutorial: Ink Pen.
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https://youtu.be/w4kZX5IJomQ

Propiedades de Herramienta Rotulador

Rotulador es una pluma que tiene su propia fuente de
tinta y generalmente una punta hecha de fibras porosas
y presionadas tales como fieltro. Puede ajustar los
pardmetros de acuerdo a sus necesidades:

Tamaiio - Ajuste el tamafio del rotulador (1-100).

Bullet | Chisel

Presion - Ajuste el espesor del rotulador (1-100).

Propiedades de Herramienta Aerégrafo

Size

Aerodgrafo es una herramienta pequefia, operada por
Pressure aire que rocia diversos medios incluyendo la tinta y el
tinte. Puede ajustar los pardmetros de acuerdo a sus

necesidades:

Tamaiio - Ajuste el tamafio del aerdégrafo (1-100).
Presion - Ajuste la presion del aerégrafo (1-100) —
Influya la densidad del aerdgrafo.

Obtenga mds informaciones sobre la herramienta ldpiz, rotulador y aerégrafo en este
tutorial: Pencil, Marker & Airbrush.
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https://youtu.be/Exseenfag04

Propiedades de Herramienta Borrador

s Tamaiio - Ajuste el tamafio del borrador (1-100).

Pressure =0 Presién - Ajuste la presidn del borrador (1-100).
[] Keep Layer Wek

Mantener Capa Himeda - Active esta opcidn si desea
que el borrador mantiene el drea borrada humeda para
pintura posterior. El borrador seque completamente el
area borrada por defecto.

SUGERENCIA: Puede ajustar la punta del borrador de un
ldpiz de tableta grdfica a borrador en Rebelle via
“Preferencias -> Herramientas (mantener)” /
“Preferences -> Tools (hold)”. Seleccione “Borrador” y lo
ajuste al “Ldpiz (Borrador)” en la parte inferior de la

ventana.

Obtenga mds informaciones sobre la herramienta borrador en este tutorial: Eraser.

Propiedades de Herramienta Fusionar

Esta herramienta fusione los colores y pinceladas.

Tamaio — Ajuste el tamafio de la herramienta Fusionar
(1-100).

Presion - Ajuste la presion de la herramienta Fusionar
(1-100).

SUGERENCIA: Puede fusionar colores con el toque de un
dedo en las tabletas con pantallas tdctiles. Puede
cambiar esto en cualquier momento en el panel de
Preferencias.
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https://youtu.be/AkkuuS66adc

Size

Pressure

[J smudge Only Wek

Propiedades de Herramienta Manchar
Esta herramienta mancha las partes himedas y secas de
la pintura.

Tamaio - Ajuste el tamafio de la herramienta Manchar
(1-100).

Presion - Ajuste la presidn de la herramienta Manchar
(1-100).

Manchar Sélo Himedo - Active esta opcidn si desea
manchar sélo partes humedas de la pintura. Cuando se
desactiva, esta herramienta mancha partes humedas y
secas de la pintura:

Manchar Sélo Huimedo Manchar Todo - humedo y seco

Obtenga mds informaciones sobre la herramienta fusionar y manchar en este tutorial: Blend

& Smudge.

Size

@

Wekt1

Propiedades de Herramienta Mojar

Tamaiio - Ajuste el tamafio de la herramienta Mojar (1-
100).

Agua - Seleccione una cantidad de agua.

Cuanta mas agua se selecciona, el mas hiumedo el lienzo
se pone.
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https://youtu.be/twtmeIJ-O5I
https://youtu.be/twtmeIJ-O5I

Obtenga mds informaciones sobre la simulacion de fluidos en Rebelle y sobre la herramienta
mojar en este tutorial: Fluid simulation & Water tool.

Propiedades de Herramienda Secar

o

2Ze

Tamaiio - Ajuste el tamafio de la herramienta Secar

Absorbem (1_100)
[ Keep Layer Wek

Absorbencia - Seleccione un poder de absorcién del
lienzo. Cuanto mayor es el nimero seleccionado, el
mas rapido la agua se absorbe.

Mantener Capa Himeda - Active esta opcidn si desea
que la herramienta Secar mantiene el drea secada
himeda para pintura posterior. La herramienta Secar
seque completamente el area por defecto.

SUGERENCIA: Herramientas Mojar y Secar también
tienen pinceles para elegir - ahora puede crear varias

salpicaduras humedas agradables y otros efectos
humedos.

NOTA: Las Herramientas Mojar y Secar automdticamente activan modo de ‘Mostrar
Humedo’. Puede cambiarlo a través Menu: Archivo -> Preferencias -> Herramientas (File ->
Preferences -> Tools) donde desactive la opcion ‘Mostrar capa humeda cuando se ulitiza la
herramienta Mojar o Secar’.

Obtenga mds informaciones sobre como pausar la simulacion y sobre la herramienta secar
en este tutorial: Pause & Dry tool.

Propiedades de Herramienta Soplar

Esta herramienta sopla un color que es humedo en la
direccion de su movimiento.

Tamaiio - Ajuste el tamafio de la herramienta Soplar (1-
100).
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https://youtu.be/JhP1ZuDp16o
https://youtu.be/XiH0urPpzcs

SUGERENCIA: Mover la herramienta soplar sobre la pintura humeda sopla las dreas

humedas. En dreas secas, crea efectos de gotas.

Obtenga mds informaciones sobre la herramienta soplar en estos tutoriales: Tilt & Blow tool

& New 'DropEngine' and Improved Blow Tool.

Mix Color:

Sample:

Sample

New color

Color sample

Original color

Propiedades de Herramienta Escoger Color

Esta herramienta le permite escoger color de la capay
del lienzo y mezclarla con otro color.

? Mezclar Colores - Presione el botén "Mezclar
Colores" o mantenga la tecla "X" para mezclar el color
escogido con el color anterior.

Muestra:

~ Capa Actual - El color se escogid sélo de una capa
activa.

= Todas Capas - El color se escogid de todas las capas
excepto un color del lienzo de fondo.

= Todas Capas y Lienzo - El color se escogié de todas
las capas que incluyendo el lienzo de fondo.

Tamaio de Muestra - El tamafio promedio de la
muestra.

Cuando la herramienta Escoger Color se selecciona el
cursor cambia a un circulo con tres zonas de colores
diferentes:

Color Original - El color seleccionado.

Muestra de Color (Sample) - El color del lienzo debajo
del disco.

Color Nuevo (New Color) - El color seleccionado nuevo.

Obtenga mds informaciones sobre la herramienta escoger color en este tutorial: Pick color

tool.
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https://youtu.be/QNknfXouFlI?t=6m3s
https://youtu.be/vQJTw2KbLRk
https://youtu.be/4njSpSO_69w
https://youtu.be/4njSpSO_69w

Propiedades de Herramienta Transformar

W
M

Transforme la capa actual y su posicidn.

wWidth 128 X - Ajuste la posicion X de la capa.

Height 900 Y - Ajuste la posicion Y de la capa.

Angle  0.00° Cuando ambas posiciones se establecen a 0, la capa se
<A transforma al lado izquierdo y superior del lienzo.

Anchura - Ajuste la anchura de la capa.
Altura - Ajuste la altura de la capa.
Angulo - Ajuste el dngulo de la rotacion.

- . .
=3 Voltear Verticalmente - Voltee la capa verticalmente.

A Voltear Horizontalmente - Voltee la capa horizontalmente.

La siguiente imagen muestra cédmo utilizar la Herramienta Transformar con el ratén, stylus
de la tableta y el toque:

Scale
N g B
<% Move 9 Rotate
= 4 = %
Use two fingers 6 o Use mouse, finger or pen

to transform layer. to transform layer.

Mover - Mueve una capa transformada o capas seleccionadas.

Escalar - Escale para aumentar o reducir una capa transformada en relacion a su esquina
superior izquierda. Puede escalar una capa horizontalmente, verticalmente o ambos. Utilice
teclado Shift para escalar proporcionalmente. Utilice teclado Alt para escalar una capa con
respecto a su centro.

Rotar - Herramienta rote una capa o capas transformadas alrededor de su centro. Utilice
teclado Shift para bloquear la rotacidn en angulos de 15 grados. Puede cambiar el angulo
predeterminado en Preferencias -> Herramientas -> Transformacion.
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Mueve, escale y rote con ratdn, stylus o con el toque. Utilice dos dedos para mover, rotar y
escalar la capa o capas simultaneamente. Mas informacion sobre el soporte tactil en Rebelle
se puede encontrar en la seccién Soporte Multitactil.

SUGERENCIA: Puede desactivar la capacidad de "Usar dos dedos para rotar el lienzo" en
Preferencias -> Tableta -> Opciones de tableta. Todavia podrd mover o escalar lienzo usando
dos dedos después.

Obtenga mds informaciones sobre la herramienta transformar en este tutorial: Transform
Tool.

Propiedades de Seleccién

Seleccione un area especifica del lienzo y realice
operaciones en este area seleccionada.

i

Tolerance 0 Hay cinco tipos de herramienta Seleccion disponibles:
[ Antialiasing

] Contiguous P

(1 Use Alpha ... Rectangulo - Cree selecciones rectangulares

haciendo clicy arrastrando sobre el lienzo.

"._.* Elipse - Cree selecciones elipticas haciendo clicy
arrastrando sobre el lienzo.

Utilice el atajo Shift para escalar la seleccidn rectangular
o eliptica proporcionalmente.

Utilice el atajo Alt para escalar la seleccidn en relacion a
su centro.

Utilice el atajo Shift para habilitar la rotacién en dngulos
de 15 grados. Puede cambiar el angulo predeterminado
en el panel Preferencias -> Herramientas en
"Transformacion".

-

2 Poligono - Cree selecciones poligonales. Haga clic para colocar un punto de seleccién,
suelte el botén del ratén y haga clic para colocar el punto siguiente. Para terminar creacién
de la seleccidn poligonal haga clic en el primer punto de nuevo o presione Enter - el Ultimo
punto se vinculara automaticamente al primer punto.

Nota: Confirme la seleccion rectangular, eliptica y poligonal pulsando Enter o haciendo clic en
la ventana grdfica fuera de la drea seleccionada.
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https://youtu.be/aHVWrQtDYcs
https://youtu.be/aHVWrQtDYcs

-~

.-’ A Mano Alzada - Cree selecciones a mano alzada dibujando un contorno alrededor del
area que desea seleccionar. Cuando se suelta el ratdn el final de la linea se conectard
automadticamente a su inicio.

als

#~ Varita Méagica - Crea selecciones basadas en el tono y el color de los pixeles. Puede
especificar cualquiera de los siguientes:

- Tolerancia - Determina la gama de colores de los pixeles seleccionados. Introduzca un valor
en pixeles, entre 0 y 255. El valor O significa que solo se seleccionaran los pixeles que son del
mismo color que el pixel especifico en el que hizo clic. El valor mayor que O representa los
tonos de pixeles mas oscuros y claros que se seleccionaran también

- Suavizado - Crea una seleccién de bordes mas suaves.

- Contiguo - Selecciona solo zonas adyacentes con los mismos colores. De lo contrario, se
seleccionan todos los pixeles de la imagen completa con los mismos colores.

- Usar Aplha - Determina el canal alfa de los pixeles seleccionados.

Obtenga mds informaciones sobre la herramienta varita mdgica en este tutorial: Using the
Magic Wand Tool.

Hay tres modos de cdmo una nueva seleccion se afiade a cualquier seleccidn actual en el
lienzo:

N Seleccion Nueva - Sustituya la seleccién actual por la nueva seleccion.

‘ Afadir a Seleccion - Afiada una nueva seleccién a la seleccidn actual para crear un nuevo
resultado. (Atajo: Shift)

h Restar de la Seleccidn - Reste el area de la nueva selecciéon de la seleccion actual para
crear un nuevo resultado. (Atajo: Alt)

l] Invertir Seleccidn - Invierta la seleccidn actual. (Shortcut Ctrl + Shift + 1 / Cmd + Shift + 1)

N Seleccionar Todo - Seleccione el contenido de la capa actual. Puede seleccionar todo
también utilizando atajo Ctrl + A /Cmd + A o a través del menu Editar -> Seleccionar Todo.

D Deseleccionar Todo - Anule la seleccién actual. Puede deseleccionar todo también
utilizando atajo Ctrl + D /Cmd + D o a través del menu Editar -> Deseleccionar Todo.

Puede encontrar mas informacion sobre como usar las selecciones en Rebelle en la seccion
Trabajar con Selecciones.

Obtenga mds informaciones sobre selecciones de Rebelle en este tutorial: Selections.
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https://youtu.be/yBt6mIKQYV8
https://youtu.be/yBt6mIKQYV8
https://youtu.be/YcOvCe_Tr0s

Propiedades de Tamaiio de Lienzo

Cambie el tamafio de la imagen, cambie el DPI, extienda
o recorte el lienzo.

width

Height 21.01 Para cambiar el tamafio de la imagen, establezca el

B Lock Ratio ancho, alto y DPI de la nueva imagen escribiendo los
valores en los cuadros. Confirme presionando el botén
OK en la parte inferior del lienzo.

InfFo:

También puede cambiar el tamafio de la imagen de
forma interactiva haciendo clic en uno de los puntos de
control y arrastrando la imagen al tamafio deseado.
Active ‘Mantener Aspecto Original’ o use atajo ‘Shift’
para escalar la imagen proporcionalmente.

Para extender o recortar el lienzo, deseleccione
‘Tamano de Imagen’, después haga clic y arrastra uno
de los puntos de control. Confirme presionando el
botdn OK en la parte inferior del lienzo.

SUGERENCIA: Active la herramienta Tamafo de la imagen utilizando atajo Ctrl+Alt+l. Active
la herramienta Tamafo del lienzo utilizando atajo Ctri+Alt+C.

NOTA: Papeles con barbas se adaptardn a un nuevo tamafio del lienzo. Puede mostrar u
ocultar los barbas desde la ventana 'Seleccionar Lienzo'.

Obtenga mds informaciones sobre tamafo de la imagen y del lienzo en este tutorial: Canvas
size & Crop tool.
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https://youtu.be/uiFDYl-Bfh8
https://youtu.be/uiFDYl-Bfh8

Panel de Creador de Pinceles

Puede create sus pinceles personalizados en
el panel Creador de Pinceles. Abra el panel

con el botén == en el panel Propiedades o a
travéz el menu Ventana.

Nombre de Pincel - El nombre del pincel se
muestra en la parte superior. Puede cambiar
el nombre del pincel haciendo doble clic en él
en la lista de pinceles (en el panel

H<Aad G <AL Propiedades).

Pressure

Vista Previa de Pincelada - La vista previa de
pincelada se coloca debajo del nombre del
Opacity . , . .
pincel y muestra cdmo se vera la pincelada

Mulkiplier

o con la configuracién actual del pincel (Tenga

i en cuenta que no todos los parametros se
Shape muestran en la vista previa del pincel).

Spacing

Forma de Pincel - Elija la forma de su pincel

personalizado. Haga clic en la miniatura de

forma (shape) y elija de una lista de formas

Opacity Jitter preestablecidas.

Size Jitker

Angle 0 Grano de Pincel - Elija el grano de su pincel.

Angle Jitter 0 Haga clic en la miniatura de grano (grano) y

Pen Tilt ¥ M smudge elija de una lista de granos preestablecidos.

Grain

El Importar - Importe la forma / el grano

desde la lista.

: B Random Start P
[ Follow Shape Rokation (] Random Splat 3 Voltear Verticalmente - Voltee la forma /

el grano verticalmente.

- Canvas
. A\ Voltear Horizontalmente - Voltee la
excure

forma / el grano horizontalmente.

I] Invertir - Invierta la forma / el grano.
NOTA: Las formas y granos son accesibles a través del menu: "Ayuda" -> "Mostrar carpeta de
Biblioteca" ("Help" -> "Show Library folder") donde puede pegar cualquier forma o grano a su

respectiva carpeta en formato PNG, JPG o BMP.
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Parametros de presion

Establezca cdmo el tamaiio y la opacidad del pincel deben estar influenciados por la presion
del lapiz de la tableta (-100 - 100). Los valores negativos invertiran los resultados de la
presién:

Tamafio 100

sk,
S

Opacidad 100 Opacidad -100

Multiplicador - Multiplica la sensitividad de presidon para el pincel (0-100).
Maximo - Eztablezca el limite maximo de presion para el pincel (0-100).

Obtenga mds informaciones sobre los ajustes multiplicador y en este tutorial: Multiplier and
Maximum.

Parametros de forma

Establezca varias opciones para la forma del pincel personalizado:

Espaciado - Controle la distancia entre las marcas del pincel (1-100). Cada marca del pincel
estd separada a lo largo de la carrera por un valor establecido, el valor 100 es igual al
tamaio completo real de la marca del pincel:

—

Espaciado 1 Espaciado 50 Espaciado 100

Variacion de Espaciado - Espaciado aleatorio (0-100):

ik
o *t*“i

29


https://youtu.be/FUz-J4hK5z0
https://youtu.be/FUz-J4hK5z0

Dispersion - La dispersion del pincel aleatoriza la colocacion de las marcas del pincel en una
pincelada hacia arriba o hacia abajo con respecto a la linea de base de la pincelada (0-100):

Opacidad - Establezca la opacidad del pincel personalizado (1-100). Las partes superpuestas
de las marcas del pincel aumentaran la opacidad adicional:

Variacion de Opacidad - Especifique cédmo la opacidad de la pintura varia en una pincelada,
hasta (pero no excediendo) el valor de opacidad especificado en el deslizador Opacidad (0-

100):
Iy

T

Variacion de Tamafio - Especifique como el tamafio de las marcas del pincel varia en una
pincelada hasta (pero no excediendo) el valor de tamano especificado en el panel
Propiedades (0-100):

Variacién de Angulo - Cada marca del pincel en la pincelada se rota aleatoriamente de
acuerdo con el dngulo actual (0-100):
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Rotacion - Seleccione el modo de rotacidn de la forma del pincel:
e Ninguno - La forma del pincel no rota.
e Seguir Trayectoria - El pincel sigue la rotacién de la trayectoria del trazo.
¢ Inclinacion de Lapiz - La forma del pincel sigue la inclinacién del lapiz.
e Rotacidn de Lapiz - La forma del pincel sigue la inclinacién del lapiz.

Follow Trajectory Pen Tilt / Rotation

SUGERENCIA: Los pinceles que siguen la trayectoria, la inclinacidn y la rotacion del lapiz
tienen un cursor que se muestra como un circulo con direccion. Puede elegir otro tipo de
cursor en Preferencias -> Herramientas -> Cursor de pintura.

NOTA: Puede seleccionar la opcién “Siempre usar "Inclinacién / Rotacion de Ldpiz" en lugar
de "Sequir Trayectoria" en Creador de Pinceles” en Preferencias -> Herramientas. Cuando se
selecciona, la forma del pincel sigue la inclinacion o rotacion del ldpiz si el Idpiz lo soporte,
incluso cuando se selecciona "Sequir Trayectoria" para la rotacion del pincel.

Obtenga mds informaciones sobre la inclinacion y rotacion de Idpiz en este tutorial: Control
the Brush Angle Via Stylus Tilt/Rotation.

Manchar - Seleccione si la marca del pincel del medio humedo (acuarela, acrilicos, pluma)
debe estar manchada o no. Cuando ‘Manchar’ estd activo, las marcas del pincel se manchan
juntas para reducir la apariencia de marcas individuales.
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https://youtu.be/ZWEK_7C7FTE
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Parametros de grano

Establezca varias opciones para el grano del pincel personalizado:

Escalar - Establezca la escala del grano (100-800). Escriba un niumero o utilice el control
deslizante para introducir un valor que sea un porcentaje del tamafio del grano.

DPI - Seleccione si la escala del grano debe usar el DPI del lienzo. Cuando se selecciona, el
grano cambiara el tamafio automaticamente cuando se cambie el DPI del lienzo.

Seguir Tamaiio de Forma - Seleccione si el grano debe seguir el tamafio de la forma o no.
Cuando esta activo el grano coincide con el tamafio de la forma del pincel.

Seguir Rotacion de Forma - Seleccione si el grano debe seguir la rotacion de la forma o no.
Cuando esta activo el grano rota con la forma dentro de la marca del pincel.

Empiezo Aleatorio - Aleatorize la posicidn del grano con respecto a la marca del pincel para
cada trazo de modo que los trazos no son idénticos.

Salpicadura Aleatoria - Aleatorize la posicion del grano con respecto a la marca del pincel
para cada marca de modo que cada marca es diferente de la anterior.

Parametros de lienzo

Textura - Establezca en qué medida la textura del lienzo debe influir en la pincelada (0-100).

= Menu de Panel de Creador de Pinceles - Guarde como Pincel Preestablecido Nuevo,
Restablezca Cambios del Pincel, Importe Pincel Preestablecido, Exporte Pincel
Preestablecido o Cierre el panel. Es posible mostrar el panel de nuevo desde el Menu de
Ventana (Window Menu).

Obtenga mds informaciones sobre el Creador de pinceles y su ajustes en esta serie de
tutoriales: Brush Creator series.
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https://youtu.be/5Y3v3WUSaoI

Como crear pincel personalizado

Haga clic en una pincel preestablecido existente en el panel Propiedades, entonces haga clic

en el botén == - panel Creador de Pinceles se abrira. Si desea realizar cambios en el pincel
seleccionado, configure facilmente la forma y el grano del pincel, parametros de presion, de
forma, de grano y del lienzo del pincel personalizado - estos cambios se aplican
automaticamente al pincel seleccionado. Cuando se realizan cambios en este pincel, nota
"Cambiado" aparecera junto al nombre del pincel.

Puede Guardar Como Pincel Preestablecido Nuevo o Restablecer Cambios de Pincel a los
valores predeterminados en cualquier momento a través del menu del panel Creador de
Pinceles.

Si desea crear un nuevo pincel preestablecido, duplique el pincel seleccionado con el botén

y realice los cambios en este pincel.
Como importar pinceles personalizados

Si desea agregar el pincel preestablecido a la herramienta seleccionada, importe el pincel a
través de 'Importar Pincel Preestablecido' en el menu del panel Propiedades o en el menu
del panel Creador de Pinceles. Se abrira una ventana de didlogo con los pinceles Rebelle.
Elija la herramienta donde se coloca su pincel, seleccidnelo y haga clic en "Abrir". Se le
pedira que elija donde se importard este pincel preestablecido: "Herramienta actual” o
"Herramienta predefinida". Elija "Herramienta actual" para importar este preajuste de pincel
a la herramienta que actualmente estd seleccionada en el panel Herramientas.

SUGERENCIA: Puede copiar fdacilmente el preajuste seleccionado a través del menu del panel
Propiedades -> Copiar pincel preestablecido al portapapeles o con el atajo Ctrl + Shift + C /
Cmd + Shift + C. Para pegar el preajuste a la herramienta seleccionada vaya al menu del
panel Propiedades -> Pegar pincel preestablecido desde portapapeles o usando atajo Ctrl +
Shift + V / Cmd + Shift + V.

Como exportar pinceles personalizados
Para exportar pincel preestablecido, vaya al menu del panel Propiedades o al menu del panel
Creator de Pinceles y seleccione 'Exportar Pincel Preestablecido’. Se abrira una ventana de

didlogo - aqui puede elegir donde se debe exportar el preajuste.

Los pinceles de Rebelle son accesibles a través del menu "Ayuda -> Mostrar Carpeta de
Biblioteca®.
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Panel de Navegador

Utilice el panel de Navegador para cambiar con rapidez
la vista de la pintura utilizando una visualizacion en
miniatura. El cuadro negro del navegador corresponde
al area visible actualmente en la ventana.

Q Reducir - Reduzca la vista de la pintura (a un
tamafio minimo de 1%).

Q Aumentar - Aumente la vista de la pintura (a un
tamafio maximo de 2000%).

Control de Zoom - Ajuste el zoom utilizando el control
de zoom (1 - 2000%).

Q Restablecer Zoom - Compruebe el valor de zoom aqui. Pulse el botdn para restablecer el
zoom al 100%.

O Encajar en Pantalla - Encaje el lienzo en la pantalla.

SUGERENCIA: También puede aumentar y reducir el lienzo manteniendo presionada la tecla
"Z" en el teclado y haciendo clic con el boton izquierdo del ratdn (o toque con el Idpiz) y
arrastrando. Mueva con el ratdn o el ldpiz hacia la derecha o hacia arriba para aumentar y
hacia la izquierda o hacia abajo para reducir.

o) Rotar Sinistrorso - Rote la ventana grafica sinistrorso.

@ Rotar Dextrorso - Rote la ventana gréfica dextrorso.
Control de Rotacion - Ajuste el valor de rotacién con el control de rotacion (-180° - 180°).

SUGERENCIA: Puede rotar la ventana grdfica presionando el atajo de teclado "R" + botdn
izquierdo del raton y arrastre.

@ Restablecer Rotacion - Pulse el botdn para restablecer el valor de rotacién al 0°.

Pl4 voltear - Voltee la ventana grafica. Herramienta Voltear en panel de Navegator voltea la
ventana grafica de forma no destructiva y no transforme el imagen. El botén esta activado
cuando la ventana grafica estd volteada.

= Menu de Panel de Navegador - Cambie a Escala de grises o cierre el panel. Es posible
mostrar el panel de nuevo desde el Menu de Ventana (Window Menu).

Obtenga mds informaciones sobre el panel de navegador en Rebelle en este tutorial:
Navigator & Navigation shortcuts.
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https://youtu.be/PT1-gPiHetk

Panel de Color

Elija su color del pincel en Panel de Color.

Color Actual - Ajuste el color actual.

Color Secundario - Ajuste el color secundario. Puede
cambiar entre el color actual y el secundario haciendo
clic en el color secundario.

Paleta de Color - Seleccione el color del pincel desde la
paleta de colores o introduzca parametros numéricos
exactos para establecer su color requerido.

Puede cambiar entre HSV, HSL, HSLuv y RGB modelos de
color:

H - Matiz del Pincel (0-359)

S - Saturacion del Pincel (0- 55)

L /V- Luminancia/Valor del Pincel (0-255)

o)

R - Red / Rojo (0-255)

G - Green / Verde (0-255)

B - Blue / Azul (0-255)

NOTA: RGB es un modelo de color dependiente del dispositivo - diferentes dispositivos /
monitores pueden reproducir un valor RGB determinado de manera diferente.

HSLuv - HSLuv le permite definir un color basado en tres dimensiones: tono, saturaciény
luminancia, pero al contrario que un modelo de color HSL basado en RGB, este modelo de
color se basa en el espacio de color CIELUV. Dos colores con un valor de luminosidad
idéntico se veran igual de brillantes, tendrdn mejor saturacién y uniformidad de tono.

= Menu de Panel de Color - Cambie entre la paleta circula y paleta cuadrada, muestre o
oclute cuadriculas o controles deslizadores, cambie entre HSV, HSL, HSLuv y RGB paleta de
color o seleccione cerrar panel. Es posible mostrar el panel de nuevo desde el Menu de
Ventana (Window Menu).

SUGERENCIA: Puede ajustar atajos de teclado personalizados para aumentar / disminuir el
matiz, saturacion y luminancia desde el panel de Preferencias. También es posible ajustar la
sensibilidad del ajuste.

Obtenga mds informaciones sobre el panel de color en Rebelle en este tutorial: Color panel
and sliders.
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Panel de Conjunto de Colores

Puede elejir su color del pincel también en Panel de
Conjunto de Colores.

Color Actual - Ajuste el color actual.

Conjunto de ultimos colores usados - Puede crear sus
colores personalizados escogiendo y haciendo clic en el
e = color en la paleta de colores. La ultima color utilizada se
ordenara en el primer lugar.

2 | smEEE l.. Conjunto de colores - Una paleta del conjunto de
[ [ 1] n [ ]|

colores seleccionado. Puede agregar colores

Aniline | Cra

personalizados - se guardaran para un proyecto de

R cerrada.

HEBE

gugEE m==mmm pintura adicional aun cuando una aplicacién esta
H [ ENEEE

‘-f, Mezclar Colores - Presione el botén "Mix Colors /

Mezclar Colores" o mantenga la tecla "X" para mezclar
el color escogido con el color anterior. Se puede mezclar colores de conjunto de color, de la
paleta o del lienzo.

Ejemplo: Si quiere que su color rojo a ser mds naranja en el tinte, haga clic en la muestra de
color naranja o de pixeles de color naranja sobre lienzo - el espectro se moverd hacia el tinte
rojo-anaranjado. Cuanto mds se hace clic en el color naranja, el tono mds naranja se pone.

L]

" Ordenar por Matiz - Ordene colores por su valor de Matiz. Cuando desactivado, el color
ultimo afiadido se ordenara como primero.

/ B— Agrega y elimina colores personalizados desde Conjunto de Colores.

Conjuntos de Colores Personalizados - Cree su propio conjunto de colores. Haga clic en el
botén para agregar el nuevo conjunto, el botén @ para duplicar el conjunto

seleccionado o B para eliminar conjunto seleccionado.
Puede cambiar el orden de conjuntos con arrastar y soltar o cambiar el nombre del
conjunto seleccionado haciendo doble clic.

= Menu de Panel de Conjunto de Colores:

- Iconos Grandes - Active miniaturas grandes de muestras.

- Mostrar Nombres de Colores - Muestre nombres de colores. Puede cambiar el nombre de
color seleccionado haciendo doble clic.

- Crear Conjunto de Colores desde Archivo de Imagen - Cree un conjunto de colores del
imagen seleccionado. Se creara el conjunto nuevo con un maximo de 16 colores.

- Crear Conjunto de Colores desde Ultimos Colores Usados - Cree un conjunto de colores a
partir de los colores que usé recientemente para pintar.
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- Crear Conjunto de Colores desde Archivo de Texto - Cree un conjunto de colores a partir
de un archivo de texto en formato .txt o .colors. El formato de un archivo de texto debe ser
dos columnas divididas por una clave de tabulador:

La primera columna consiste en el formato hexa del color - canal RGB (por ejemplo, negro:
#000000).

La segunda columna consiste en los nombres de los colores. Si esta columna esta vacia,
Rebelle mostrara el nombre del color como formato hexa de la primera columna.

- Cerrar - Cierre el panel de Conjunto de Colores. Es posible mostrar el panel de nuevo desde
el Menu de Ventana (Window Menu).

Paleta de Colores de Sistema

Después de hacer clic en un color actual en la esquina superior izquierda del Panel de Color,
una nueva ventana de Seleccionar color con una Paleta de Colores del Sistema aparece. Esta
paleta se ve y se comporta de manera diferente en Mac OS y Windows:

Basic colors | 9 ONS) Colars =)
RiEEE =

Q L .

&

Pick Screen Color

Custom colors

Add to Custom Colors

Cancel =

Paleta de Colores de Sistema en Windows = UL L

(Cancel) ( OK )

Z

. . Paleta de Colores de Sistema en Mac 0S
Para usuarios de Windows:

Puede escoger cualquier color de la pantalla haciendo clic en

un botdn de "Pick Screen Color". Al pasar por encima de su pantalla veras HSV, RGB y HTML
parametros de un color.

El uso de la opcidon 'Custom Colors" en la ventana de Paleta de colores para guardar los
colores no es necesario. Si desea guardar su color personalisado, le recomendamos que
utilice el botén "Agregar / Add" directamente en el Panel Conjunto de Colores.

Obtenga mds informaciones sobre conjuntos de color en Rebelle en este tutorial: Last used
colors & Color sets.
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Panel de Capas

(]
@ Mostrar Himedo - Muestre las partes hiumedas de
la capa actual.

C, () see 555 aft

El/@ Pausar Difusion - Pause la difusion. Cuando
estd pausada, el botdn esta marcado.

Blending Normal

£2% Humedecer Capa - Humedece la capa actual.

385 Secar Capa - Seque la capa actual, el lienzo no es
himedo.
ale Secar Rapido - Seque la capa actual, el agua se

elimina de la pintura, pero el lienzo permanece
himedo.

Note: Al cambiar capas, la capa actual se seca rapida (el
agua se seca, pero el lienzo permanece humedo) y la
capa nueva es seleccionada después.

Fusidn - 23 modos de fusién: Normal, Oscurecer, Multiplicar, Subexponer Color,
Subexposicion Lineal, Aclarar, Trama, Sobreexponer Color, Sobreexposicidn Lineal,
Superponer, Luz Suave, Luz Fuerte, Luz Intensa, Luz Lineal, Luz Focal, Mezcla Definida,
Diferencia, Exclusién, Restar, Tono, Saturacién, Reguladores y Luminosidad.

Opacidad - Ajuste la opacidad de la capa. (0-100).

a Bloquear Capa - Bloquee la capa o capas seleccionadas para protegerlos de cambios no
deseados. Capa de trazado se bloqueard de forma predeterminada.

':' Bloquear Transparencia - Bloquee pixeles transparentes en la capa seleccionada.
Cuando se pinta un trazo en una capay se bloquean pixeles transparentes en esta capa, cada
accion se aplicara sélo en este trazo, no en los pixeles transparentes detras de él.

M cCapa de Fluido Enmascarador - Bloquear pixeles opacos en la capa seleccionada. Esta
capa servird como una mascara y se marcara con la letra 'M'. Al pintar en "Capa

Influenciada" ® todos los pixeles estaran enmascarados por la Capa de Fluido
Enmascarador. Esta es una forma rapida y facil de colorear bocetos e imagenes.
Puede activar otras capas para tener en cuenta la capa de fluido enmascarador haciendo clic

enel punto ® del lado derecho de la capa.
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Mas informaciones sobre como usar herramientas enmascaradores se puede encontrar en la
seccién Trabajar con Herramientas de Enmascaramiento.

T Capa de Trazado - Establezca una capa activa como una capa de trazado para trazar la
imagen y sus colores a una capa separada. La capa de trazado se marcard con la letra 'T".
Esta capa es una guia para las formas y colores a su pintura - puede ser una imagen o foto.

® capa Influenciada - Establezca una capa que se vera influenciada por la capa de fluido
enmascarador o por la capa de trazado. Puede activar y desactivar facilmente el funcion de
trazar o enmascarar para las capas seleccionadas.

® Ojo - Muestra u oculta la capa activa.

Lienzo - Elija desde texturas y colores del lienzo predeterminados.
Se puede controlar escalado de la textura del lienzo utilizando el control Escalado de
Textura (50-400%) en la ventana Seleccionar Lienzo.

Usar Barbas - Seleccione si desea aplicar barbas en el papel seleccionado (los papeles con

barbas estan marcados con elicono ).

Obtener mas papeles... - Haga clic para ser redirigido a nuestro sitio web donde puede
obtener mas papeles.

m/ B- Importe o elimine la textura del lienzo seleccionado de la lista.

Color de Lienzo - Seleccione el color del lienzo personalizado a través de la paleta
predeterminada del sistema.

Lista de Colores de Lienzo - Seleccione el color del lienzo de la lista de colores. Cada papel
tiene su color predeterminado. El color predeterminado del papel seleccionado es el primero
en la lista y esta marcado como 'Default Color'.

/ B— Agrega o elimina colores a / de la lista.
Haga clic en OK para aplicar los cambios o en Cancelar si decide no hacerlo.

SUGERENCIA: Haga clic en el ojo @ gl lado de un icono del lienzo para mostrar u ocultar la
textura del lienzo. Cuando se oculta, se puede guardar la pintura con el fondo transparente.

Puede encontrar mas informacion acerca de las texturas del papel en la seccién Lienzos
Artisticos.
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© Mostrar Seleccidn - Muestre un area seleccionada actual en el lienzo donde se realizaran
otras operaciones. El drea inactiva fuera de la seleccién esta coloreada.

Ajustes Visuales - Abre o cierre el panel de Ajustes Visuales.

Limpiar Capa - Limpie el contenido de la capa (atajo Del).

) (=)

Nueva Capa - Agrega una nueva capa.

@ Duplicar Capa - Duplique capa o capas activas.

Fusionar Capas - Fusione mas capas en una capa. Si una sola capa esta seleccionada, se
fusionara automaticamente con la capa debajo de ella.

B Eliminar Capa - Elimine la capa o mas capas seleccionadas.
SUGERENCIA: Arrastre la capa seleccionada arriba de cualquiera de estos botones para

ejecutar sus funciones en esa capa.

Se puede cambiar el nombre de una capa activa con un doble clic sobre ella en una Lista de
Capas.
Se puede arrastrar y soltar las capas para acomodarlos en el orden deseado.

= Mend de Panel de Capas - Seleccione una Capa de Trazado o cierre el panel. Es posible
mostrar el panel de nuevo desde el Menu de Ventana (Window Menu).

Obtenga mds informaciones sobre las capas en Rebelle en este tutorial: Layers.
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Panel de Inclinacion

Herramienta inclinacién afecta el movimiento de pintura himeday
estd representado por un circulo con un puntero, que se puede
mover y rotar. Active / desactive la inclinacién haciendo clic en el
circulo central. Establezca la direccién y el angulo de la inclinacién del
lienzo haciendo clic en el puntero. Cuanto mas larga es la linea de la
inclinacién, el mayor es el dngulo.

Nota: La velocidad de chorreados de color depende de la inclinacidon del lienzo, cantidad de
agua y color en la pintura.

= Menu de Panel de Inclinacién

- Bloquear Inclinacion al Lienzo - Bloquee la inclinacidon para mantener su direccidon cuando
rota el lienzo.

- Usar Aceleréometro - Utilice el acelerémetro de la tableta grafica para influir la inclinacién
del lienzo y flujo del color mediante la inclinacién de la tableta. Puede ajustar la sensibilidad
del acelerémetro en Preferencias -> Herramientas (Preferences -> Tools).

- Centrar Acelerémetro - Centre el acelerémetro para establecer un grado cero.

- Cerrar - Cierre el Panel. Es posible mostrar el panel de nuevo desde el Menu de Ventana
(Window Menu).

Obtenga mds informaciones sobre el panel de inclinacion capas en este tutorial: Tilt & Blow
tool.
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Panel de Esténciles

Los esténciles son herramientas utilizadas para colocar
un disefio, forma o linea particular en el lienzo. El
esténcil funciona como una delgada hoja de cartén o
plastico con un disefio o letras cortadas de él utilizado

Art Nouvesu

para producir el disefio de corte en la superficie de
abajo mediante la aplicacion de pintura a través de los
cortes.

Grupo de Esténciles - Puede crear nuevos grupos de los
esténciles desde el menu del panel Esténciles -> Afadir
grupo o con el botén derecho del mouse, haga clic en el
panel Esténciles -> Afiadir grupo.

Cambie el nombre del grupo haciendo doble clic en su
nombre, ingrese el nuevo nombre y presione Enter.

Oculte el grupo haciendo clic con el botén izquierdo del
raton.

Puede eliminar el grupo seleccionado del menu del
panel Esténciles -> Eliminar grupo.

Lista de Esténciles - La lista de los esténciles disponibles en Rebelle. Puede cambiar el orden
arrastrando un esténcil seleccionado a la posicion deseada. Haga doble clic en un esténcil
para cambiar su nombre.

[*]
@ Mostrar | Ocultar Esténcil - Muestre o oculte todos los esténciles activos en / desde el
lienzo.

El Crear Esténcil desde Archivo de Imagen - Cree un esténcil desde archivo de imagen.
Después de seleccionar el archivo, el esténcil se crea automaticamente y se agrega al panel
Esténciles.

B Eliminar Esténcil desde Biblioteca - Elimine un esténcil seleccionado de la lista de
esténciles.

= Menu de Panel de Esténciles:

- lconos Grandes - Elija miniaturas grandes de los esténciles en la Lista de esténciles.

- Crear Esténcil desde Archivo de Imagen - Cree un esténcil desde archivo de imagen.
Después de seleccionar el archivo, el esténcil se crea automaticamente y se agrega al panel
Esténciles.

- Crear Esténcil desde Capa (alpha) - Cree un esténcil desde la capa actual.

- Crear Esténcil desde Capa (imagen) - Cree un esténcil desde la imagen en la capa actual.
- Crear Esténcil desde Seleccidn - Cree un esténcil desde la seleccion actual.
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- Aiadir Grupo - Aifiada un nuevo grupo de esténciles.

- Eliminar Grupo - Elimine el grupo actual de esténciles.

- Mantener Esténciles Activadas Quando Estan Ocultas - Los esténciles agregadas al lienzo
estaran activas incluso cuando estén ocultas.

- Eliminar Todos Esténciles desde Lienzo - Elimine todos esténciles activos desde el lienzo.
- Cerrar - Cierre el Panel. Es posible mostrar el panel de nuevo desde el Menu de Ventana
(Window Menu).

SUGERENCIA: Puede arrastrar y soltar esténciles al panel de Esténciles desde su disco o
directamente desde el navegador web.

Como trabajar con Esténciles

Para agregar el esténcil al lienzo, elije el esténcil de la lista y haga clic en él.

Cuando el esténcil se coloca sobre lienzo, aparecera un Menu de Esténcil
en la esquina superior derecha:

Mover esténcil - Mueve el esténcil haciendo clic en el botén movery
arrastrando sobre el lienzo. Puede seleccionar y mover el esténcil también
con el boton derecho del raton o manteniendo la barra espaciadora +
boton derecho del raton (LMB). En tabletas con pantalla tactil seleccione y
mueva el esténcil con un solo toque de dedo.

Rotar esténcil - Rote el esténcil haciendo clic en el botén rotar y arrastrando sobre el
lienzo. En tabletas con pantalla tactil, rote el esténcil con dos dedos.

Escalar esténcil - Escala el esténcil haciendo clic en el botdn escalar y arrastrando sobre
el lienzo. En tabletas con pantalla tactil escala el esténcil con dos dedos.

Menu de esténcil - Seleccione para invertir, voltear horizontalmente / verticalmente,
bloguear o eliminar el esténcil:
- Invertir - Invierta el area activa donde se puede aplicar la pintura.
- Voltear horizontalmente - Voltee el esténcil horizontalmente.
- Voltear verticalmente - Voltee el esténcil verticalmente.
- Borda - Crea una borda alrededor del esténcil para evitar pintar en el lienzo exterior.
- Azulejo - Cree un esténcil infinito.
- Mantener Aspecto Original - Escale el esténcil proporcionalmente.
- Bloquear - Bloquee el esténcil actual para evitar que se mueva, escala o acciones de
rotacion.
- Eliminar - Elimine el esténcil actual del lienzo.
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SUGERENCIA: No sélo la pintura se evita del lugar donde se coloca el esténcil, pero también el
agua y la pintura humeda toma el esténcil en cuenta. Por ejemplo, si se moja una capa donde
se coloca el esténcil, toda la capa se mojard, excepto el drea cubierta por el esténcil. Esto
funciona al revés también - si el esténcil se coloca en la capa humeda y se pulsa el boton
"Secar Capa", todo estd seco, excepto el drea del esténcil.

Obtenga mds informaciones sobre los esténciles en Rebelle en estos tutoriales: Stencils &

Stencils Improvements.
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Panel de Vista Previa

Vista previa del lienzo actual en un panel separado.
Abra el panel Vista previa a través del menu Ventana o
usando el atajo Ctrl + E. Cambia el tamafio del panel y
colécalo en la pantalla. Puede configurar el panel en
pantalla completa y colocarlo en un monitor secundario
para obtener una gran vista previa de su trabajo.

Panel de Referencia

Cargue una imagen de referencia que servird como guia
para pinta.

Abra el panel de referencia a través del menu Ventana o
usando el atajo Ctr/ + R. Cambia el tamafio del panely
coldcalo en la pantalla. Puede configurar el panel en
pantalla completa y colocarlo en un monitor secundario
para obtener una vista previa grande de la imagen de
referencia.

Zoom el imagen de referencia usando Z + botén izquierdo de ratén (LMB) o atajo
Ctrl+Spacebar+LMB.

Mueve el imagen de referencia usando botén derecho de ratén (RMB) o atajo
Spacebar+LMB.

= Menu de Panel de Referencia:

- Abrir... - Abre el imagen de referencia en el formato .jpg, .png, .bmp o .tif.

- Eliminar - Elimina el imagen de referencia desde el panel.

- Escala de Grises - Vea el imagen de referencia en el mode escala de grises.

- Cerrar - Cierre el Panel. Es posible mostrar el panel de nuevo desde el Menu de Ventana
(Window Menu).

SUGERENCIA: Puede arrastrar y soltar los imagenes al panel de referencia desde su disco o
directamente desde el navegador web.

Obtenga mds informaciones sobre los paneles vista previa y referencia en este tutorial:
Preview & Reference panel..
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Panel de Ajustes Visuales

Ajuste la configuracion del comportamiento de la
acuarela, acrilico y lienzo.

Waktercolor Behavior

Abra el panel de Ajustes Visuales a través del menu
Presets Default Ventana o haga clic en el botén en el panel Capas.
Absorbency X

, Comportamiento de Acuarela

Edge Darkening

Canvas Influence

Preajustes - Seleccione desde los preajustes de ‘Por

[ Creakte Drips

Do s Defecto’, ‘Prensa Caliente’, ‘Prensa Fria‘, ‘Rugoso’y
ATIp SIZE

Drip Length ‘Japonés’ para simular el comportamiento de acuarela en
Jrip Lengkh

diferentes tipos del papel.

Acrlic

Impasto Depth El papel prensado caliente tiene una superficie lisa y
dura y una textura uniforme. Ofrece un acabado elegante

Canvas y es ideal para trabajos en medios mixtos. Un paso mas

Texture Visibility es el papel prensado en frio: es la textura mas versatil y

popular, su superficie semirruda es adecuada tanto para

[ Always show texture on paink

trabajos detallados como para pinturas suaves. Cuando

desliza el pincel sobre él, parte de la pintura se asienta
sobre él y omite las hendiduras de la textura granulosa,
dejandolos en blanco. Esto crea una pincelada bellamente texturizada.

El papel rugoso tiene una textura pronunciada que es buena para las pinturas y crea
pinceladas expresivas que pueden proporcionar mucho cardcter y emocién a una pintura.
También puede usar papel japonés. Ningun tipo de papel es intrinsecamente mejor que el
otro. Todo depende de sus necesidades, sus técnicas preferidas y el aspecto que busca en su
pintura.

SUGERENCIA: Puede obtener mds papeles en nuestro sitio web: Rebelle papers.

Absorbencia - Establezca la absorbencia del papel (0-10). Representa la rapidez con que el
papel absorbe la pintura. Cuando se establece en 0, la pintura se difunde durante un periodo
de tiempo mas largo.

Oscurecimiento de Borde - Establezca el grado de oscuridad de los bordes de los trazos de
acuarela cuando se seca (0-10). Cuando se establece en 0, los bordes no se oscurecen
durante la difusion.

Influencia de Lienzo - Establezca cuanto debe influir la textura del lienzo en la pintura (0-10).
Cuando se establece al maximo, la pintura gana una textura del lienzo debajo.

Crear Gotas - Seleccione si se deben formar gotas o no.
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Tamaio de Gotas - Establezca tamafio de gotas (1-10).
Longitud de Gotas - Establezca longitud de gotas (1-10).

= Menu de preajustes - Restablezca los pardmetros del preajuste de papel seleccionado o
Guarde en preajuste 'Personalizado’'.

Acrilico

Esperor de Impasto - Establezca la visibilidad de la estructura de los trazos acrilicos (1-10):

Impasto Depth

Lienzo

Visibilidad de Textura - Controle la visibilidad de la textura del lienzo (0-10).
Siempre mostrar la textura en la pintura - Seleccione si la textura del lienzo siempre debe
estar visible en la pintura, incluso cuando el lienzo esté oculto.

Obtenga mds informaciones sobre los ajustes visuales en estos tutoriales: Introducing the
Visual Settings Panel and Understanding Visual Settings Parameters.
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Barra de Menu

Archivo - Contiene acciones relacionadas con cargar, guardar y exportar sus pinturas.
Editar - Contiene articulos relacionados con la edicidn del proceso de pintura y el lienzo.
Capa - Contiene acciones relacionadas con las capas.

Filtro - Contiene acciones relacionadas con la correccion de color.

Vista - Contiene acciones relacionadas con la ventana gréfica.

Ventana - Contiene acciones relacionadas con la interfaz de usuario.

Comunidad - Contiene enlaces al foro de la comunidad, galeria, su cuenta y opcion para
publicar pinturas.

Ayuda - Contiene acciones que permiten obtener ayuda de la aplicacién o buscar
actualizaciones en la pagina web.

Menu de Archivo

El Menu de Archivo contiene acciones relacionadas con su pintura de la siguiente manera:

Nuevo... - Abre el cuadro de didlogo que le permite crear una nueva pintura con los nuevos
ajustes, abrir una pitnura reciente quardada o abrir imagenes.

Puede establecer la anchura vy la altura de la nueva pintura y una DPI; elige mantener
aspecto original; cambie entre la orientacion vertical y horizontal; ajuste la textura, color del
lienzo y escalado de la textura (mas sobre los papeles en la seccion Lienzos Artisticos):

Open... Canvas 5ize: Canvas Size Info:
DPL: 200 =

Jinch

* Favorites

A4 Defaulk

[ Don't Show on Startup
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Puede abrir cualquier imagen en el formato de archivo .reb, .psd, .png, .jpg, .bomp y .tif de su
computadora a través el botén “Abrir...”.

Sus trabajos recientes se enumeran en el lado izquierdo del cuadro de didlogo Nueva
Pintura. Haga clic en el nombre del trabajo para abrirlo. Para borrar la lista de los trabajos
recientes, haga clic en el botdn "Limpiar Lista".

Para crear una nueva pintura, puede establecer sus propias dimensiones en pixeles,
centimetros y pulgadas con DPI. De acuerdo con el DPI que configurd, la informacion del
tamario de la imagen se calculard automaticamente en centimetros y pulgadas.

También puede elegir entre una variedad de ajustes preestablecidos de tamafio de lienzo de

Impresion y Pantalla o agregar / eliminar ajustes preestablecidos usando los botones @/

Guarde sus preajustes favoritos en 'Favoritos' marcandolos con una estrella *

' Bloguear Aspecto Original - Haga clic para bloquear aspecto original. Cuando resaltado,

a

v el aspecto original esta bloqueado.

D - Cambie a orientacion vertical.

O. Cambie a orientacion horizontal.

NOTA: Tenga en cuenta que el establecimiento de las resoluciones mds grandes para su
imagen puede retrasar su ordenador; especialmente si se utiliza una gran cantidad de agua
en la pintura.

Después de hacer clic en un icono de Lienzo, una nueva ventana aparece con una eleccién de
lienzos artisticos preestablecidos.

Abrir... - Abre el cuadro de didlogo que le permite cargar una imagen desde disco en el
formato .reb, .psd, .png, .jpg, .bmp y .tif.

Abrir Reciente - Abre una de las ultimas pinturas guardadas. Puede limpiar la lista usando la
funcién ‘Limpiar lista’“.

Guardar... - Guarde su pintura. Si no ha guardado anteriormente, se le pedira que introduzca
el nombre.

Guardar Como... - Guarde una copia de su pintura actual como una nueva en formatos de
.reb, .psd, .png, .jpg, .bomp y .tif.

Guardar Iterativo - Guarde versiones numeradas secuencialmente de una imagen. La

primera vez, " 1" se afiade al nombre del archivo. Posteriormente, cada vez el nimero se

incrementa en 1y se crea un nuevo archivo numerados secuencialmente.
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Importar Imagen... - Importe una imagen en formatos .psd, .png, .jpg, .bmp y .tif como la
nueva capa.
Importar Recursos... - Importe los papeles y otros recursos disponibles en el sitio web.

SUGERENCIA: Rebelle guarda automdticamente el trabajo mientras pinta. Cuando esto

suceda, verd un icono que aparecerd en la esquina superior izquierda del lienzo y al lado
del cursor de pintura. Puede configurar el temporizador de autoguardar o desactivar la
funcion de autoguardar mediante Preferencias -> General -> Autoguardar.

Quitar - Cierre la aplicacién. (Sélo en Windows).

SUGERENCIA: También puede arrastrar y soltar (Drag & Drop) una imagen desde cualquier
aplicacion, archivo o navegador de Internet directamente a Rebelle si la aplicacion lo
permite.

Para obtener mas informacion sobre cdmo crear, cargar y guardar sus pinturas, consulte la
seccion Crear, Cargar y Guargar Pinturas mas adelante en el manual.

Menu de Editar

Deshacer - Deshace la ultima operacion de pintura que ha realizado. NUmero de pasos para
deshacer depende de la memoria de su ordenador. NUmero maximo de estos pasos es 30.
Rehacer - Rehace la ultima operacidn de deshacer.

NOTA: Si no puede deshacer, compruebe la configuracion ,Mdx. Memoria‘usada en
Preferencias -> General -> Memoria. Establézcalo en valores mds altos para poder usar las
funciones Deshacer / Rehacer.

Cortar - Corte la seleccidn actual o una capa seleccionada al portapapeles.
Copiar - Copie la seleccién actual o una capa seleccionada al portapapeles.
Pegar - Pegue la seleccidn actual o una capa seleccionada a la capa nueva.

Tamaiio de Imagen - Cambie el tamafio del lienzo y del imagen.
Tamaiio de Lienzo - Agrande o recorte el lienzo.

Seleccionar Todo - Seleccione la capa completa.
Deseleccionar Todo - Deseleccione la seleccion actual desde el lienzo.
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Invertir Seleccidn - Invierta la seleccion actual.
Herramienta Regla - Active la herramienta regla en el lienzo.
Herramienta Perspectiva - Active la herramienta perspectiva en el lienzo.

Mas informaciones sobre las herramientas regla y perspectiva se puede obtener en la
seccién Trabajar con Regla y Perspectiva.

Preferencias... - Ajuste Preferencias General, Preferencias de Herramientas, de Color, de
Tableta y del Teclado. Puede encontrar mas informacién en la seccidon Preferencias mas
adelante en el manual.

Atajos de Teclado - Abre y edita los atajos del teclado.

Menu de Capa

Nueva Capa - Agrega una nueva capa.

Duplicar Capa - Duplica capa o capas activas.
Fusionar Capas - Fusione capas en una sola capa.
Eliminar Capa - Elimine capa o capas activas.

Mostrar Capa- Muestre u oculte la capa individual.
Capa de Fluido Enmascarador - Establezca una capa activa como una capa de fluido
enmascarador Bloquear pixeles opacos en la capa seleccionada. Esta capa servira como una

mdscara y se marcard con la letra 'M'. Al pintar en "Capa Influenciada" ® todos los pixeles
estaran enmascarados por la Capa de Fluido Enmascarador.

Capa de Trazado - Establezca una capa activa
como una capa de trazado de referencia (una
letra T en vista previa de Capa aparecerad). Esta

capa es una guia para las formas y colores a su
pintura - puede ser una imagen o foto. Puede ajustar la capa de trazado también desde el
menu de panel de capas.

Capa Influenciada - Establezca una capa que se vera influenciada por la capa de fluido
enmascarador o por la capa de trazado. Puede activar y desactivar facilmente el funcién de
trazar o enmascarar para las capas seleccionadas.

Transformar Capa - Mueve y escale la capa activa (atajo Ctr/+T)
Limpiar Capa - Limpia la capa (atajo Del).
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Menu de Filtro

Brillo/Contraste... - Ajuste el brillo y el contraste de los colores en una capa actual o en una
seleccion.

Obtenga mds informaciones sobre los ajustes brillo y contraste en este tutorial: Filters:
Brightness/Contrast.

Matiz/Saturacion... - Ajuste el brillo y el matiz, la saturacién y la luminancia de los colores en
una capa actual o en una seleccion.

Equilibrio de Color... - Ajuste la mezcla global de colores en una capa actual o en una
seleccion para la correcciéon de color generalizada.

Arrastre un regulador hacia el color que desee aumentar en la imagen; arrastre un regulador
lejos del color que desee disminuir en la imagen. Los valores pueden estar comprendidos
entre -100 y +100.

Seleccione Sombras, Medios tonos o lluminaciones para seleccionar la gama tonal en la que
desea enfocar los cambios.

Seleccione Conservar luminosidad para impedir que cambien los valores de luminosidad de
la imagen mientras cambia el color. Esta opcion mantiene el equilibrio tonal de la imagen.

Haga clic en 'Restablecer' para restablecer los valores, 'Aplicar' para aplicar los cambios o
'Cancelar' si decide no hacerlo.

Filtro de Color... - Aplique el filtro de color en una capa actual o en una seleccién. Elija el
color de la paleta de colores del sistema. Para ajustar la cantidad de color aplicado a la
imagen, use el control deslizante Fuerza - una mayor fuerza da como resultado un ajuste de
color mas intenso.

Seleccione Conservar luminosidad para impedir que cambien los valores de luminosidad de
la imagen mientras cambia el color. Esta opcion mantiene el equilibrio tonal de la imagen.

Colorear... - Colorea la capa con el deslizador de Matiz, Saturacién y Fuerza.

Obtenga mds informaciones sobre los ajustes matiz, saturacion, equilibrio, filtro de color y
colorear en este tutorial: Filters: Color Modifiers.

Desaturar - Convierta todos los colores en una capa actual o en una seleccion a los tonos de
gris correspondientes. Los colores en la capa siguen siendo valores RGB con tres
componentes. Elija tonos de gris en funcidn de ‘Luminosidad’ o 'Promedio’. Active 'Vista
previa' para verificar los cambios de color en tiempo real.
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Obtenga mds informaciones sobre los ajustes de desaturar en este tutorial: Filters:
Desaturate.

Invertir - Invierte todos los colores de pixeles y los valores de brillo en una capa actual o en
una seleccion.

NOTA: Al ajustar los filtros, la difusion se pondrd en pausa en la capa actual.

Blanco a Transparente - Convierta el color blanco de una capa actual en un canal alfa.
Negro a Transparente - Convierta el color negro de una capa actual en un canal alfa.

SUGERENCIA: Importe un trabajo de linea con fondo blanco a Rebelle 3. Aplique el filtro
‘Blanco a Transparente'. El fondo blanco se volverd transparente mientras el trabajo de linea
permanezca. A continuacion, puede crear fdcilmente una mdscara a partir de este trabajo de
linea y colorearla en una capa separada.

Obtenga mds informaciones sobre los ajustes blanco/negro a transparente en este tutorial:
Filters: Invert and White/Black to Alpha.

Menu de Vista

Aumentar - Aumente la vista de la pintura (a tamafio maximo de 2000%).

Reducir - Reduzca la vista de la pintura (a un minimo del 1%).

Aumentar al 100% - Comprueba el valor de zoom. Pulse el botdn para restablecer el zoom al
100%.

Encajar en Pantalla - Encaje el lienzo en la pantalla.

Ajustar al Lienzo - Establezca esta opcidn para permitir que las transformaciones se ajusten
a los bordes del lienzo.

Escala de grises - Vea el lienzo en escala de grises.
Mostrar Cursor - Muestre u oculte el cursor.

Permanecer Arriba - Aplicacién permanecera siempre en la parte superior de otras
aplicaciones.

Pantalla Completa - Cambie la ventana de la aplicacién en modo de pantalla completa.
(Presione Esc para salir).
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Menu de Ventana

Herramientas - Muestre u oculte el Panel de Herramientas.
Propiedades - Muestre u oculte el Panel de Propiedades.

Color - Muestre u oculte el Panel de Color.

Conjunto de Color - Muestre u oculte el Panel de Conjunto de Color.
Inclinaciéon - Muestre u oculte el Panel de Inclinacién.

Navegador - Muestre u oculte el panel de Navegador.

Capas - Muestre u oculte el Panel de Capas.

Esténciles - Muestre u oculte el Panel de Esténciles.

Vista Previa - Muestre u oculte el Panel de Vista Previa.

Referencia - Muestre u oculte el Panel de Referencia.

Creador de Pinceles - Muestre u oculte el Panel de Creador de Pinceles.
Ajustes Visuales - Muestre u oculte el Panel de Ajustes Visuales.

Mostrar Paneles - Muestre u oculte los Paneles para conseguir mas espacio para la pintura.
Bloquear Paneles - Bloquee la configuracion de los paneles de cualquier cambio no deseado.
Cuando estan bloqueados, no es posible desacoplar paneles, acoplar paneles flotantes o
fusionar paneles.

Importar Disefio - Importe el disefio de interfaz de usuario de Rebelle previamente
guardado.
Exportar Disefio - Guarde un disefio de interfaz de usuario Rebelle personalizado.

Restablecer a Predeterminado - Restablezca la interfaz a interfaz predeterminada.

Menu de Comunidad

Foro - Visite el foro de Escape Motions para leer las preguntas frecuentes, encontrar
informacidn atil, participar en discusiones sobre el software, obtener sugerencias y trucos,
compartir sus comentarios y mas.

Galeria - Navega por la galeria y publica tus pinturas.

Mi cuenta - Visite su cuenta donde puede cargar su pintura a la galeria, editar su perfil y
cambiar la contrasefa, o descargar el software y los recursos comprados.

Publicar... - Publique su pintura en la Galeria de Communidad. Introduzca el nombre de la
pintura, opcionalmente escriba una descripcidn y etiquetas.
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Menu de Ayuda

Ayuda - Abra este Manual de Usuario.

Enviar Comentarios... - Envienos sus comentarios si usted tiene cualquier problema, una
idea o simplemente le gusta el programa. Puede elegir entre 3 tipos de comentarios:
Bravo - ¢ Te gustaria expresar como genial Rebelle es? Entonces...
Idea - ¢ Tiene alguna caracteristica que seria una gran adicién a Rebelle? Entonces...
Bug - ¢ Encontro cualquier comportamiento curioso al utilizar Rebelle? Entonces...

... introduzca su correo electrénico y mensaje - leemos cada uno. ©

Feedback type:

ofg Bravo 3§ Idea % Bug

Email:
email@email.com

Message:

Pagina web de Rebelle - Enlace a la pagina web: rebelle.escapemotions.com

Intro Tutorial - Muestra el Intro Tutorial. Este tutorial le guiara a través de las herramientas
mas esenciales en Rebelle.

Video Tutoriales - Visite el canal de Youtube de Escape Motions para ver los tutoriales de
Rebelle.

Acerca de Rebelle - Obtenga un poco de informacién basica acerca de Rebelle, copyright y
créditos.

Idioma - Seleccione el idioma de la interfaz de usuario de Rebelle. Reinicie Rebelle para
aplicar los cambios.

Mostrar Carpeta de Biblioteca ... - Muestra carpeta donde se guardan los pinceles, datos,
documentos y lienzos.

Buscar actualizaciones... - Este botdn es visible cuando hay nuevas actualizaciones
disponibles.
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Preferencias

Rebelle le permite personalizar muchos ajustes y atajos de teclado en la ventana
Preferencias accesible desde el menu Archivo. Establezca las Preferencias General,
Preferencias de Herramientas, de Color, de la Tableta y del Teclado en Rebelle.

Preferencias General

Pantalla de Inicio - No mostrar cuadro de dialégo de "Nueva Pintura" al inicializacion de la
aplicacién - Marque esta opcion si desea que el cuadro de didlogo “Nueva Pintura”
abre cada vez que inicie la aplicacion.

Interfaz - Ajuste la escala para cambiar el tamafio de la interfaz (70-200%). La escala
predeterminada es 100%.

Lienzo - Aumentar al cursor - Marque esta opcion si desea aumentar al cursor y no al
centro del lienzo.

Opciones de Jpeg - Establezca la calidad del archivo Jpeg (0-100). Cuanto menor sea el
ajuste, menor sera la calidad del archivo .jpeg guardado.

Sensibilidad de Box de Editar - Ajuste la sensibilidad de editar del spinbox para el Ratdn
o Tableta grafica (1-100) - Establezca un valor mas alto para que los cuadros (boxes)
de Rebelle sean mas sensibles a la resistencia de la pluma/el ratén.

Memoria - Establezca la memoria maxima que Rebelle puede usar.

Idioma - Seleccione el idioma de la interfaz de usuario. Seleccione si los idiomas se deben
actualizar automaticamente o no.

Autoguardar - Habilite la funcién de autoguardar que guardara automaticamente el trabajo
actual desde Rebelle. Establezca el tiempo (en minutos) que desea que Rebelle
guarde automdaticamente. Puede encontrar sus trabajos guardados
automaticamente en el menu Ayuda -> Mostrar carpeta de biblioteca -> Autosave.

Preferencias de Herramientas

Cursor de Pintura - Seleccione la apariencia del cursor para pintar. Elija entre circulo, circulo
con direccidn, circulo con cruz y cursor de cruz.

Pinceles - Seleccionar el ultimo pincel usado cuando el color es escogido de la paleta -
Habilite esta opcidn si desea que el Ultimo pincel usado para ser seleccionado de
forma automatica después de escoger un color del Panel de Color.

- Mostrar capa humeda cuando se ulitiza herramienta Mojar o Secar - Habilite esta
opcioén si desea que herramientas Mojar y Secar activan el modo Mostrar Himedo.
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- Siempre usar "Inclinacién / Rotacion de Lapiz" en lugar de "Seguir Trayectoria" en
Creador de Pinceles - Active esta opcién para que la forma del pincel siga la
inclinacién o rotacidn del picel, incluso cuando se seleccione "Seguir Trayectoria"
para la rotacion del pincel.

Motor de Pinceles - Establezca CPU o GPU (experimental) motor de pinceles. Si usted tiene
una tarjeta gréfica dedicada puede configurar Rebelle para ejecutar en GPU - este
motor sigue siendo inestable y puede bloquearse inesperadamente, porque es por
ahora sélo experimental.

Lazy Mouse - Ajuste la fuerza del Lazy Mouse (0-10). El mayor es nimero de control de Lazy
Mouse, las lineas mds suaves se pueden pintar.

Acelerémetro - Ajuste la sensibilidad del acelerémetro (1-10). Cuanto mayor sea el nimero
que establezca, mas sensible sera la inclinacidn al utilizar la inclinacién de la tableta,
lo que resulta en un flujo de acuarela mas rapido.

Transformacion - Establezca el angulo de bloqueo personalizado para transformar cuando se
usa Shift con rotacion.

Preferencias de Color

Tamano de Muestra de Color de Trazado - Elija el tamafio promedio de la muestra de
trazado de color (1 pixel, 3x3 pixeles, 5x5 pixeles).

Mezcla de Color - Ajuste la sensibilidad de Mezcla de Color (1-100). La sensibilidad influye el
nuimero de pasos entre dos colores mezclados. Cuando la sensibilidad es baja, se
requieren menos pasos (clics) para alcanzar el segundo color de la mezcla. Cuando
la sensibilidad es alta, se necesita mas clics para alcanzar el segundo color
mezclado.

Ajustar Color con Atajo del Teclado - Ajuste la sensibilidad de atajos para ajustar colores (1-
10). La sensibilidad influye la distancia entre dos colores. Cuando la sensibilidad es
alta, la distancia entre dos colores en la paleta de colores serd menor.

Mostrar Himedo - Establezca el color de la vista previa de areas humedas en el modo
'Mostrar Himedo’.

Esténciles - Establezca el color personalizado de los esténciles y su opacidad (1-100).

Seleccion - Establezca el color personalizado de la seleccién y su opacidad (1-100).

Preferencias de Tableta

Opciones de Tableta - Seleccione Usar el posicidon del ratdon o stylus y dispositivo Wacom
(WinTab) o Microsoft Ink. Reinicié de Rebelle es necesario para aplicar los cambios.
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- Habilitar multi-toque - Activar / desactivar gestos multitouch en Rebelle - Cuando
esta deshabilitado, no podra utilizar el toque de dedo para mover, escalar o rotar
funciones en el lienzo.
- Usar dos dedos para rotar el lienzo - Cuando estd desactivado, no puede rotar el
lienzo con dos dedos en Rebelle. El toque con dos dedos seguira funcionando para
escalar y mover.
- Sensibilidad de Touchpad - Ajuste la sensibilidad para touchpads y trackpads (1-
100%) - cuando se establece en valores mas altos, la sensibilidad de la accion de
'mover' con el toque en trackpads sera mas significativa.

Sensibilidad de Presion de Stylus - Ajuste la sensibilidad de presién de stylus. Cuando se
establece en ‘Suave’ se requiere menos presion, cuando se establece en ‘Firme’ se
requiere mas presion.

Preferencias de Teclado

Establezca los atajos de teclado personalizados.
Haga clic en Restablecer Atajo Predeterminado para restablecer el atajo seleccionado, haga
clicen [ x] para eliminar el atajo seleccionado.
Para agregar mas atajos para una accién, haga clic en el botén [ +].
Menu de Atajos del Teclado:
- Importar Atajos - Abre los atajos de teclado previamente guardados.
- Exportar Atajos - Guarde los atajos actuales como un archivo .xml personalizado.
- Restablecer Todos - Restablecer todos los atajos a los atajos predeterminados.

Haga clic en OK para confirmar los cambios realizados en Preferencias o Cancelar, si no lo
desea.
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Empezar a Pintar

Opciones de Flujo de Trabajo

Empezar una nueva pintura con el lienzo en blanco

1. Haga clic en Archivo -> Nuevo... y una nueva ventana aparecera.

2. Establezca una anchura, una altura de la imagen, la textura del papel y DPI de imagen.

3. Elija el color desde el Panel de Color o Conjunto de Colores.

4. Elija una herramienta, ajuste el tamafio del pincel y otros pardmetros en el Panel de
Propiedades y empiece a pintar.

Empezar con una foto o una imagen de referencia

1. Haga clic en Archivo -> Abrir... y elija su imagen de referencia.

2. Haga clic en Agregar Capa en Panel de Capas para crear una nueva capa en la parte

superior de la capa de referencia.

3. Elija el color desde el Panel de Color o Conjunto de Colores.

4. Elija una herramienta, ajuste el tamafio del pincel y otros parametros en el Panel de
Propiedades y empiece a pintar.

Puede importar un dibujo previamente escaneada o dibujado en un software tercero en
formato .png, .jpg, .bmp y .tif haciendo clic en Menu -> Archivo -> Importar... (File ->
Import...).

También puede arrastrar y soltar una imagen desde cualquier aplicacién o navegador de
Internet directamente a Rebelle como una nueva capa.

Trabajar con Agua

Al pintar con un medio hiumedo (acuarela, acrilico y pluma) se puede establecer la cantidad
de agua. Con mas agua, el color se extendera mas rapido sobre la capa y colores himedos se
mezclan.

No solamente los colores pueden ser himedos, con un botén '"Humedecer Capa' 22 (en
’Panel de Capas’) se puede humedecer la capa completa. Cémo la pintura se mezcla y se seca
depende del agua y la humedad del papel por debajo de ella.

Para ver si o donde una pintura esta himeda, haga clic en el botén ‘Mostrar Himedo’ @.
Un color azul claro muestra la humedad del lienzo y del color - la mayor cantidad de agua se
aplica, el mas oscuro el color azul se mostrara.
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Color Layer/Capa de Show Wet/Mostrar Fast Dry/Secar Rapido  Wet the Dry the
Color Humedo Layer/Humedecer Capa Layer/Secar Capa

Para acelerar su proceso de pintura hemos implementado 2 funciones:

Botoén 'Secar Capa' 345 seca completamente la capa activa con todo su contenido —la
pintura, el lienzo y agua aplicada.

Puede utilizar un botdn de 'Secar Rapido' f.‘fri cuando quiere agua para ser removido de su
capa activa pero desea mantener la humedad del lienzo.

SUGERENCIA: Pause la simulacion de fluidos en cualquier momento durante la pintura

haciendo clic en el botdn Pausar Difusion en Panel de Capas: @ / @

Se pueden utilizar diferentes técnicas de pintura para obtener diversos efectos. En la
siguiente imagen puede ver como diferentes combinaciones interactian entre si. El mas
himedo el papel y el color, el mas difunde el color. Sin embargo, las herramientas secas
(pastel, 1apiz, rotulador y aerdgrafo) no se difunden en la pintura menos himeda; se
difunden de acuerdo a humedad de su pintura.

Dry on Dry Wet on Dry Wet on Wet Paper

W 5\
~ 5 S

Si desea obtener mas informacion sobre la técnica adecuada acuarela, recomendamos ver
nuestros tutoriales en YouTube.
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https://youtu.be/DxOVcsTjmVU

Opcidn de Trazar una Imagen

Rebelle le permite crear pinturas trazando los colores de una imagen seleccionada. Puede
arrastrar y soltar imagenes directamente desde cualquier aplicacidon o navegador de Internet
directamente a Rebelle como una nueva capa. El uso de la opcién de trazar le permite
recrear imagenes existentes en su propia manera.

Cuando se utiliza el trazado de color, el color se aplica para cada trazo. Esto significa que
cada trazo de pincelada recoge el pigmento de color desde el primer "clic" y lo utiliza hasta
gue hace el otro clic.

Rebelle no traza todos los colores de la capa de trazado durante un solo trazo.

Cémo trazar una imagen existente o importada:

1. Haga clic en Menu -> Archivo -> Importar... para abrir el cuadro de dialogo de Import.
Una imagen se importa como una nueva capa. También puede arrastrar y soltar
imagenes directamente desde cualquier aplicacién o navegador de Internet.
Seleccione esta capa y haga clic en Menu -> Capa -> Capa de Trazado. Una capa se
establece como una capa de trazado de referencia (un pequefio T en la capa de vista
previa aparecerd). Esta capa es una guia para las formas y colores a su pintura.

2. Agregue una nueva capa. Para trazar los colores de la imagen en esta capa, activela
como una "Capa Influenciada" desde Menu -> Capa -> Capa Influenciada o haciendo

clic en el botén ® en panel Capas.
3. Ahora ya estad listo para trazar los colores de su imagen de referencia en una capa
activa.

Si Trazado de Color no es seleccionado usted puede pintar con otros colores. Deseleccione
Capa de Trazado desde Menu -> Capa -> Capa de Trazado.

Capa de Trazado estd bloqueado por defecto para protegerla de cambios no deseados.
Puede desbloquear la capa haciendo clic en el botén de "bloqueo".

Trabajar con Selecciones

En Rebelle se puede seleccionar facilmente el drea del lienzo para realizar operaciones
especificas sélo dentro de este area seleccionada. Las selecciones sirven como herramientas
de enmascaramiento que bloquean las areas del lienzo que no desea cambiar.

Las operaciones que se pueden realizar en la seleccion en Rebelle incluyen pintar,
transformar, cortar, copiar y pegar. También es posible crear el esténciles de la seleccion.
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Cuando una seleccidn esta activa, se dibuja en el lienzo con guiones. Todo lo que esta dentro
del drea delimitada estd seleccionado, todo lo que estd fuera no esta seleccionado.

Pintar dentro de seleccidon

Cree una mascara simple en el lienzo utilizando la herramienta de seleccién. Elija entre la
seleccion rectangular, eliptica, poligonal, a mano alzada o varita magica y cree la seleccidn
en el lienzo. Usted pintara dentro de la seleccidn, el drea exterior permanecerad intacta. Para

pintar en las areas fuera de la seleccidn, haga clic en el botdn "Invertir seleccion" l] en el
panel Propiedades de la Seleccion.

Nota: Puede ver rdpidamente su seleccion actual mediante el boton Mostrar Seleccion © en
el panel Capas. El drea no activa en el lienzo es de color rojo.

Transformar seleccion

Seleccione las partes especificas de su pintura usando la herramienta de seleccién. Para
transformar esta seleccion, haga clic en Transformar en el panel Herramientas o el atajo Ctrl
+T/Cmd + T. Puede mover, escalar, rotar o voltear la seleccién horizontal o verticalmente.
Se puede encontrar mas informacién sobre transformacion en la seccion Propiedades de

Herramienta Transformar.

Nota: Cuando se selecciona y transforma una parte de la pintura en la capa, la confirmacion
de la transformacion colocard el drea transformada en una nueva capa.

Cuando se selecciona y transforma toda la pintura en la capa, permanecerd en la misma
capa.

Cortar, Copiar y Pegar Seleccion

Puede realizar funciones simples de cortar, copiar y pegar en el drea seleccionada del lienzo
mediante el menu Editar o con los atajos de teclado.

Use Ctrl + X / Cmd + X para cortar la seleccién y Ctrl + V /Cmd + V para pegar la seleccién.
Puede cortar y pegar también desde el menu Editar. Su seleccidn se pegara a una capa
separada.

Use Ctrl + C / Cmd + C para copiar la seleccion y Ctrl + V /Cmd + V para pegar la seleccidn.
También puede copiar y pegar desde el menu Editar. Su seleccion se pegard a una capa
separada.
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Seleccionar Todo / Deseleccionar Todo

Seleccione el contenido de la capa actual con atajo Ctr/ / Cmd + A o mediante el menu
Editar -> Seleccionar todo.

Deseleccione la seleccién actual con atajo Ctrl / Cmd + D atajo o mediante el menu
Editar -> Deseleccionar todo.

Se puede cambiar estos atajos en cualquier momento a través del panel Preferencias ->
Teclado -> Editar.

Invertir seleccion

Invierte la seleccion actual. El drea seleccionada se desactivara. Invierte seleccidon usando
Ctrl / Cmd + Shift + | atajo o mediante el menu Editar -> Invertir seleccion.

Se puede cambiar el atajos en cualquier momento a través del panel Preferencias -> Teclado
-> Editar.

Crear esténcil de seleccién
En Rebelle puede crear un esténcil de su seleccion a través del Menu del Panel de esténciles.
Dibuje su seleccion en el lienzo y confirme la seleccidn, después vaya al Menu del panel de

los esténciles y haga clic en "Crear Esténcil a partir de Seleccidén". El nuevo esténcil se creard
automaticamente y se agregara al panel de esténciles.
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Trabajar con Regla y Perspectiva

Linea recta con la tecla Shift
La manera mas facil de pintar una linea recta en Rebelle 3 es presionar la tecla 'Shift'
mientras se usa cualquier herramienta de dibujo. Presionando Shift establece un extremo de
la regla. Ajuste manualmente el otro extremo, presione el botén del ratén o una plumayy,
naturalmente, dibuje la linea entre estos dos puntos.
La herramienta se ajusta a la posicion vertical y horizontal cuando esta cerca del angulo
recto: para desactivar esto, mantenga presionadas las teclas Shift + Ctrl.

Herramienta Regla
Active la herramienta Regla desde el menu Editar o
presionando Shift + R.
La herramienta regla consiste en tres puntos de control.
Free Hand Vuelva a colocar la regla en el lienzo haciendo clicy
arrastrando el punto de control central sin cambiar el

Lock Control Poinks angulo.

A Mano Alzada - Active esta opcion para dar a las lineas rectas un atractivo dibujado

a mano.

Bloquear Puntos de Control - Bloguee los puntos de control de la regla para evitar que
mueva accidentalmente los puntos.

Herramienta Perspectiva
Active la herramienta Perspectiva desde el menu Editar o
presionando Shift + P.

Elija entre una, dos o tres puntos de perspectiva.

_) One Point
P e e A Mano Alzada - Active esta opcion para dar a las lineas

® Three Points rectas un atractivo dibujado a mano.

Bloquear Puntos de Control - Bloquee los puntos de

control de la regla para evitar que mueva

Free Hand ,

accidentalmente los puntos.

Lock Control Poinks Bloquear Horizontalmente - Bloquee la perspectiva

horizontalmente.

Lock Horizontally

Obtenga mds informaciones sobre los lineas rectas, herramientas regla y perspective en
estos tutoriales: Drawing straight lines & Ruler panel, Perspective panel and One, Two and

Three-Point Perspective.
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https://youtu.be/vFRBMs5m_JM
https://youtu.be/XBXYWpxwRTI
https://youtu.be/w2-8r8F5Irs
https://youtu.be/w2-8r8F5Irs

Trabajar con Herramientas de Enmascaramiento

Rebelle ofrece varias formas de crear una mascara en la capa: esténciles, selecciones y capa
de fluido enmascarador:

Esténciles - Los esténciles son herramientas utilizadas para colocar un disefio, forma o linea
particular en el lienzo. El esténcil funciona como una delgada hoja de cartén o plastico con
un disefio o letras cortadas de él utilizado para producir el disefio de corte en la superficie de
abajo mediante la aplicacion de pintura a través de los cortes. Rebelle tiene esténciles
predeterminadas que se pueden encontrar en el panel Esténciles. Puede crear esténciles
personalizadas a partir de un archivo de imagen, desde una capa o desde una seleccién a
través del menu del panel Esténciles.

Selecciones - Las selecciones son herramientas faciles de enmascarar que le permiten
bloquear areas del lienzo que no desea cambiar. Cuando se selecciona un area, las
operaciones que llevas a cabo se limitan a esa area especifica. Por ejemplo, si selecciona un
area y pinta, la pintura solo se aplicara dentro del area seleccionada. También puede pintar
una seleccion usando la seleccion a mano alzada y crear esténciles a través del menu del
panel Esténciles -> Crear esténcil desde seleccion. El nuevo esténcil se creard
automaticamente y se agregara a su lista de Esténciles.

Capa de Fluido Enmascarador - Use la capa de fluido enmascarador para bloquear los
pixeles opacos en la capa seleccionada. Esta capa servird como una capa de
enmascaramiento y se marcara con la letra "M". Al pintar en "Capa influenciada" (.), todos
los pixeles estaran enmascarados por la "Capa de fluido enmascarador". Esta es una forma
rapida y facil de colorear bocetos e imagenes.

Puede activar otras capas para tener en cuenta la capa de enmascaramiento haciendo clic en
el punto en la parte derecha de la capa.

SUGERENCIA: Capa de fluido enmascarador es util para colorear imdgenes. Ejemplo: Pinte o
importe cualquier imagen en blanco y negro (imdgenes predisefiadas) en la Capa 1. Puede
usar el filtro "Blanco a Transparente" del menu "Filtro" si la imagen no tiene un canal alfa.
Agregue nueva Capa 2. Establezca la Capa 1 como una "Capa de Fluido enmascarador "y la
Capa 2 como "Capa Influenciada". Use "Humedecer Capa" del panel "Capas" en la Capa 2,
por lo que la capa estard completamente humeda. Luego pinta con acuarelas en la Capa 2, la
acuarela se difundira en el agua y la Capa 1 se comportard como un fluido enmascarador.
También puede pintar en la Capa 1 (desbloquear la capa) y volver a pintar los bordes de
enmascaramiento.

Obtenga mds informaciones sobre los capas de fluido enmascarador y capas influenciadas en
este tutorial: Masking fluid layers & Influenced layers.
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https://youtu.be/xmbJYehxtos

Soporte Multitactil

El soporte multitactil estd disponible tanto para Windows y Mac O y ofrece un mayor apoyo
para las tabletas con pantallas tactiles y multitactiles. Puede desplazar, rotar y hacer zoom la
ventana grafica o la capa individual. Esto pofrece una forma sencilla y sensible de
posicionamiento y navegacion por el lienzo.

Use dos dedos para rotar y mover el lienzo al mismo tiempo,
moviéndolos en un movimiento circular mientras lo pasa
simultdneamete a través de la tableta. Al mismo tiempo se puede
zoom la ventana grafica apretando los dedos juntos o separandolos.

Use un dedo para la herramienta Fusionar de forma predeterminada.
Puede configurarlo para cualquier otra herramienta (o para mover el
lienzo) en el panel de Preferencias -> Teclado -> Herramientas
(mantener) y configurarlo para ‘Toque’.
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Lienzos Artisticos

Hay varias texturas y colores del lienzo predeterminadas para elegir en la ventana
‘Seleccionar Lienzo’:

Canvas Texkture

Whike Simple

m/ B— Importe o elimine la textura del lienzo a / desde ventana ‘Textura del Lienzo’.
Obtener mas papeles... - Haga clic para ser redirigido a nuestro sitio web donde puede
obtener mas papeles.

Se puede escalar la textura utilizando el control de control de Escalado de Textura.
Usar Barbas - Seleccione si desea aplicar barbas en el papel seleccionado o no (los papeles

con barbas estan marcados con el icono ).

Obtenga mds informaciones sobre los papeles nuevos y barbas en Rebelle 3 en este tutorial:
New Papers and Deckled Edges.

Grupos de Texturas de Lienzo - Puede crear nuevos grupos de textura del lienzo desde el
menu Textura de lienzo -> Afadir grupo o con el botén derecho del ratén, haga clic en ->
Afadir grupo. Cambie el nombre del grupo haciendo doble clic en su nombre, ingrese el
nuevo nombre del grupo y haga clic en la tecla Enter. Para ocultar el grupo, haga clicen la
flecha en el lado izquierdo del grupo de texturas del lienzo.

Puede eliminar el grupo seleccionado del menu Textura de lienzo -> Eliminar grupo.
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https://youtu.be/rnx5x3rLORo

Color de Lienzo -Elije color del lienzo desde la paleta.
Default Color - Elije color predeterminado para el papel seleccionado.

/ B Agrega o elimine el color del lienzo a / desde ventana ‘Color del Lienzo’.

= Menu de Textura de Lienzo - Afiada el nuevo grupo de texturas o Elimine el grupo de
texturas seleccionado.

Nota 1: La textura del lienzo afecta la forma en que los pinceles y las herramientas se
comportan al pintar, mezclar, borrar o usar cualquier herramienta disponible.

Nota 2: Texturas del lienzo son accesibles a través del Menu: Ayuda -> Mostrar Carpeta de
Biblioteca... (Help -> Show Library Folder), donde se puede pegar cualquier textura del lienzo
enlosable a la carpeta del "Papers". Reinicie una aplicacion para recargar nuevos papeles.

Por ultimo, haga clic en OK para confirmar, o Cancelar, si no lo desea.
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Crear, Cargar y Guargar Pinturas

Crear Nueva Pintura

Para crear una nueva pintura, seleccione la opcién Nuevo... en el Menu de Archivo. Al hacer
esto, ventana de Nueva Pintura aparecerd. Esta ventana le permite ajustar el tamafio de la
nueva pintura y configurar los ajustes del lienzo. En seccion "Informacién sobre Tamafio de
Imagen” puede comprobar el tamafio de impresion de la imagen tales como anchura, altura
y DPI.

Al hacer clic en el Icono del Lienzo se puede seleccionar la textura, el color y escalado de Ia
textura.

Por ultimo, haga clic en OK para crear una nueva pintura, o Cancelar, si no lo desea.

Abrir Pintura

Para abrir una pintura, seleccione la opcion Abrir... en el Menu de Archivo. Este panel le
permite abrir una imagen o ilustracion previamente guardada en el formato de archivo .reb,
.psd, .png, .jpg, .bmp y .tif como un nuevo projecto.

Por ultimo, haga clic en OK para abrir la pintura, o Cancelar, si no lo desea.

Para abrir una pintura recientemente guardada, seleccione la opcién Abrir Reciente en el
Menu de Archivo. Esta opcidn le permite seleccionar una de las ultimas pinturas guardadas
en .reb, .psd, .png, .jpg, .bmp y .tif formatos de archivo.

Guardar Pintura

Para guardar la pintura, utilice la opciéon Guardar... en el Menu de Archivo. El formato nativo
es formato de archivo REB, que contiene toda la informacién acerca de la pintura y las
capas. Utilice este formato si desea continuar con la pintura mas tarde. Le recomendamos
gue guarde su trabajo periédicamente para evitar cualquier problema, mientras que
acostumbrarse a un nuevo software.

Si desea guardar la pintura con los ajustes especificas o en forma que puede ser leida por

otras aplicaciones, utilice la opcion Guardar Como... del Menu de Archivo. Le permite
guardar la pintura en el formato PSD, PNG, TIF, BMP o JPG. No es necesario fusionar capas
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para crear una copia de su pintura para la impresion o para mostrar en la web. Las capas
individuales se guardan en formato de archivo REB y PSD.

Nota: Por favor, tenga en cuenta que solo el archivo REB contiene toda la informacion de
imagen. Archivos PSD, PNG, TIF y BMP guardan solamente la informacion sobre el color y la
transparencia. La transparencia no se guarda en el formato JPG.

Por ultimo, haga clic en OK para guardar la pintura o Cancelar si no lo desea.

Guardar Iterativo - Guarde versiones numeradas secuencialmente de una imagen. La
primera vez, " 1" se afiade al nombre del archivo. Posteriormente, cada vez el nimero se
incrementa en 1y se crea un nuevo archivo numerados secuencialmente.

Guardar con Transparencia

Puede guardar su trabajo con fondo transparente ocultando la capa de Lienzo que sirve de
fondo para todas las capas. Para ocultar el lienzo, haga clic en 'Ojo' al lado de 'Lienzo' en el
panel Capas. Tal trabajo se puede guardar en formato de archivo PNG con transparencia.

Si desea que la textura sea visible en los trazos que pintd, puede activar: "Siempre mostrar la
textura en la pintura" en el panel de Ajustes visuales:

Always show canvas texture on paint

ON OFF
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Cerrar Aplicacion

Si desea cerrar una aplicacidn, se puede elegir entre las siguientes opciones dependiendo de
su sistema operativo:

Usuario de Windows Usuario de Mac OS
- haga click en Archivo -> Quitar, o - haga click en Archivo -> Quitar, o
- presione un botdn Cerrar en la esquina - presione un botdn Quitar en la esquina
superior derecha de una aplicacién o superior derecha de una aplicacién o
- utilice el atajo Ctrl+W, Ctrl+Q, Ctrl+F4 o - utilice el atajo Cmd+W, Cmd+Q o
Alt+F4 Cmd+F4

Nota: Por favor no se olvide de guardar su pintura antes de cerrar una aplicacion.
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Publicar Pintura a Galeria

Puede publicar una pintura en la Galeria directamente desde la aplicacion Rebelle o a través
del sitio web de Escape Motions Comunidad escapemotions.com/community.

Publicar Pinturas desde Rebelle

Vaya desde el menu de Rebelle: Comunidad -> Publicar. Establezca el nombre, las
descripciones y las etiquetas de la imagen y haga clic en el botdn Publicar. Su imagen se
publicara en la Galeria desde su cuenta de Comunidad.

Publicar Pinturas desde Comunidad

Cuando compré Rebelle 3, ingresd una contrasefa Unica: esta contrasefia se puede usar para
iniciar sesién en Escape Motions Comunidad. Vaya a escapemotions.com/community, haga

clic en login, ingrese su correo electronico y contrasefia para Rebelle 3.

Nota: Puede encontrar su Correo Electronico en el menu de Rebelle Ayuda -> Acerca de
Rebelle.

Para publicar su pintura, vaya a My profile y haga clic en el icono Upload. Puede arrastrary
soltar sus archivos o cargar archivos desde su computadora. Seleccione el archivo que desea
cargar y haga clic en el botén Upload. Después de que termine la carga, ingrese el nombre de
la imagen, las etiquetas, la descripcion y seleccione el software en el que se cred. Para
finalizar, haga clic en Save.

Editar su Perfil de Comunidad y Pinturas en Galeria
En su perfil, haga clic en el botdn Edit profile - puede editar su nombre de usuario, nombre y
apellido, cambiar la contrasefia, escribir una breve biografia y agregar sus cuentas sociales.
Si desea eliminar su cuenta, haga clic en "Delete my account" - se le enviara un correo
electrdénico de confirmacién. Después de confirmar, su cuenta de Comunidad sera eliminada.

Para cargar o editar sus ilustraciones, haga clic en la pestafia Portfolio.

Para acceder a los enlaces de descarga de su software, vaya a la pestafia Purchases.
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Atajos de Teclado

New... / Nuevo...

Open... / Abrir...

Save / Guardar

Save As... / Guardar Como...
Iterative Save / Guardar Iterativo
Import Image.../ Importar Imagen...
Preferences / Preferencias

Quit / Quitar

Undo / Deshacer

Redo / Rehacer

Cut / Cortar

Copy / Copiar

Paste / Pegar

Select All / Seleccionar Todo
Deselect All / Deseleccionar Todo
Invert Selecion / Invertir Seleccidn

Ruler Tool / Herramienta Regla

Windows

Ctrl+N
Ctrl+O
Ctrl+S
Ctrl+Shift+S
Ctrl+Alt+S
Ctrl+Shift+O
Ctrl+,
Ctrl+W

Ctrl+z
Ctrl+Shift+Z
Ctrl+X
Ctrl+C
Ctrl+Vv
Ctrl+A
Ctrl+D
Ctrl+Shift+l

Shift+R

Perspective Tool / Herramienta PerspectivaShift+P

Draw Straight Line / Dibujar Linea Recta
Straight Line (no locking)

Copy Brush Preset / Copiar Preajuste
Paste Brush Preset / Pegar Preajuste

Brushes / Pinceles

Eraser / Borrador

Blend / Fusién

Smudge / Manchar

Water /Agua

Dry / Secar

Blow / Soplar

Pick a color / Escoger el Color
Transform Layer / Transformar la Capa
Selection / Seleccion

Image Size / Tamafio de Imagen
Canvas Size / Tamafio de Lienzo

Lock proportions at scale /
Bloquear propociones a escala
Scale around center /

Shift
Shift+Ctrl

Ctrl+Shift+C
Ctrl+Shift+V

UEV’Z”‘IUJ

Shifto O
Altol

T o Ctrl-T
M
Ctri+Alt+
Ctrl+Alt+C

Shift

Mac OS

Cmd+N
Cmd+0O
Cmd+S
Cmd+Shift+S
Cmd+Alt+S
Cmd+Shift+0
Cmd+,
Cmd+Q

Cmd+Z
Cmd+Shift+Z
Cmd+X
Cmd+C
Cmd+V
Cmd+A
Cmd+D
Cmd+Shift+l

Shift+R
Shift+P
Shift
Shift+Ctrl

Cmd+Shift+C
Cmd+Shift+V

B
E
N
S
w
D

Shifto O
Altoll
ToCmd-T
M
Cmd+Alt+l
Cmd+Alt+C

Shift



Escalar alrededor del centro
Lock rotation at 45 degrees /
Bloquear rotacion a 45 grados
Mix / Mezclar

Show Wet / Mostrar Haimedo
Fast Dry / Secar Rapido
Paint / Pintar

Increase Brush Size /
Aumentar el Tamano del Pincel
Decrease Brush Size /
Disminuir el Tamano del Pincel
Resize Brush on Canvas /
Redimensionar Pincel en Lienzo

Move Up / Mover hacia Arriba

Move Down / Mover hacia Abajo

Move Left / Mover a lzquierda
Move Right / Mover a Derecha

Move 10x Up / Mover hacia Arriba 10x
Move 10x Down / Mover hacia Abajo 10x
Move 10x Left / Mover a Izquierda 10x
Move 10x Right / Mover a Derecha 10x

Alt

Shift

o ™ T

Ctrl

Up

Down

Left

Right

Shift + Up
Shift + Down
Shift + Left
Shift + Right

Rectangle Selection / Seleccion Rectangular 7

Ellipse Selection / Seleccidn Eliptical
Polygon Selection / Selecciéon Polygonal

Move Layers Up /

Mover Capas hacia Arriba
Move Layers Down /

Mover Capas hacia Abajo
Select Prev Layer /

Seleccionar Capa Anterior
Select Next Layer /

Seleccionar Capa Siguente
Clear Layer Content /

Limpiar el Contenido de la Capa

Increase Value +1 / Aumentar el Valor +1
Decrease Value -1 / Disminuir el Valor -1

8

9

Ctrl + [
Ctrl +]
Alt + [

Alt +]

Del

Up
Down

Increase Value +10 / Aumentar el Valor +10 Pg Up
Decrease Value -10 / Disminuirel Valor -10 Pg Down

Open Color Dialog / Abrir Dialégo de Color

/
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Alt

Shift

Cmd

Up

Down

Left

Right

Shift + Up
Shift + Down
Shift + Left
Shift + Right

7

8

9
Cmd + [
Cmd +]
Alt + [
Alt +]
Del

Up

Down

Pg Up
Pg Down



Preview / Vista Previa Ctrl+E Cmd+E

Reference Image / Referencia Ctrl+R Cmd+R

Brillo / Contraste Ctrl+G Cmd+G

Matiz / Saturacion Ctrl+U Cmd+U
Equilibrio de Color Ctrl+B Cmd+B
Desaturar Ctrl+Shift+U Cmd+Shift+U
Invertir Ctrl+l Cmd+l

Grid Palette / Cuadricula clic con Ctrl+LMB en la paleta

Rotate Canvas / Rotar Lienzo R R

Move a Canvas / Mover Lienzo Botdn derecho del ratén o Escpaciador + LMB
Select Stencil / Seleccionar Esténcil Right MouseButton (RMB) or Space Bar + LMB
Remove Stencil / Eliminar Esténcil Backspace Backspace

Show | Hide All Panels Tab Tab

Zoom In / Aumentar +/Ctrl + + +/Cmd + +

Zoom Out / Reducir -/Ctrl + - -/Cmd + -

Zoom 100% / Acercar 100% 0/Ctrl+0 0/Cmd+0

Fit to Screen / Encajar en Pantalla . .

Greyscale / Escala de Grises G G

Zoom In | Out / Aumentar | Reducir Desplazamiento o Desplazamiento + Alt

Help / Ayuda F1 F1

Nota: Puede crear ajustes personalisados para esas y otras funciones desde el Menu:
Preferencias -> Teclado (Preferences -> Keyboard).
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Derechos de Autor y Créditos

Rebelle © 2015 - 2020 Escape Motions, s.r.o.

Escape Motions Equipo:

Peter Blaskovi¢, Michal Fap$o, Lubo$ Téth, Miroslav Sedldk, Anton PozZivenec, Pavol Obuch,
Veronika Klimekova, Andrea Hornakova, Jaroslav Kasa.
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Michael Clarida, Jose Antonio Pefas, Richard Feifer, Mark Robinson, David K. Manuel, Jay
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Alexandr Miroshnikoff, Scott Burnett, Tim Shelbourne, Lubomir Zabadal, Massimo
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Neundorf.
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Video tutoriales por: Jason Maranto
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Bibliotecas usadas:
Esta aplicaciéon ha sido desarrollada con las siguientes bibliotecas:

Qt, LGPL license - http://qt-project.org/downloads/

QuaZIP, LGPL license - http://sourceforge.net/projects/quazip/

CryptoPP, Boost Software license - http://www.cryptopp.com/

ImageMagick, Apache license - http://www.imagemagick.org/

AntiGrain Geometry, LGPL license - http://agg.sourceforge.net/antigrain.com/index.html
MB WebSockets, LGPL license - https://qgt.gitorious.org/qtplayground/mbwebsockets

Gracias a Dios por todas las ideas creativas.
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Rebelle End-User Software License Agreement

Copyright 2015-2020 Escape Motions, s.r.o. All Rights Reserved.

This license is a legal agreement between you and Escape Motions for the use of Rebelle
software (the "Software"). By downloading, installing, copying, or otherwise using the
Software, you acknowledge that you have read terms and conditions of this license,
understand them, and agree to be bound by them. If you do not agree with these terms and
conditions, Escape Motions is unwilling to license the Software to you, and you are not
authorized and may not use the Software.

Permitted Use

Users of the Rebelle may use the Software for commercial, or for-profit activities as well as
for personal, non-commercial, or non-profit activities.

The Software may be installed on a computer that is for multiple users but it may not be
installed on more than one computer regardless of whether those computers are operated
simultaneously or not.

You may install the Software on multiple computers provided that not more than one of
those computers is in use simultaneously and that those computers are solely for your own
personal use.

You may not remove the copyrights notices from the Software. You may make one (1) copy
of the Software for back-up or archival purposes.

Restrictions

This is a SINGLE COPY SOFTWARE LICENSE. The Software is copyrighted and protected by law
and international treaty. This is a license, not a transfer of title, and unless you have been
granted prior, written consent from Escape Motions you may not:

a, Reproduce, distribute, or transfer the Software, or portions thereof, to any third party.

b, Sell, rent, lease, assign, or sublet the Software or portions thereof.

¢, Grant rights to any other person.

d, Modify, decompile, reverse engineer, disassemble, or create derivative works based on
the Software or the documentation in whole or in part.

e, Use the Software in violation of any international law or regulation.

You must not intentionally or unintentionally make the Software available on any web
server, ftp server, file sharing network, shared directory, or other location where any other
person can acquire a copy of the Software. You are responsible for keeping the Software
safe from being copied by others.
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Display of Copyright Notices

All copyright and proprietary notices and logos within the Software files must remain intact.

Indemnity

You agree to indemnify and hold harmless Escape Motions for any third-party claims, actions
or suits, as well as any related expenses, liabilities, damages, settlements or fees arising from
your use or misuse of the Software, or a violation of any terms of this license.

The Software may contain technical inaccuracies or typographical errors, so changes and/or
updates may be affected without notice.

Peter Blaskovic may also make improvements and/or other changes to the Software at any
time without notice.

Disclaimer Of Warranty

THE SOFTWARE IS PROVIDED \"AS IS\", WITHOUT WARRANTY OF ANY KIND, EXPRESSED OR
IMPLIED, AS TO THE SOFTWARE OR ITS OPERATION, INCLUDING, BUT NOT LIMITED TO,
WARRANTIES OF QUALITY, PERFORMANCE, NON-INFRINGEMENT, MERCHANTABILITY, OR
FITNESS FOR A PARTICULAR PURPOSE. FURTHER, PETER BLASKOVIC DOES NOT WARRANT
THAT THE SOFTWARE OR ANY RELATED SERVICE WILL ALWAYS BE AVAILABLE.

Limitations Of Liability

YOU ASSUME ALL RISK ASSOCIATED WITH THE INSTALLATION AND USE OF THE SOFTWARE.
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS OF THE SOFTWARE BE LIABLE
FOR CLAIMS, DAMAGES OR OTHER LIABILITY ARISING FROM, OUT OF, OR IN CONNECTION
WITH THE SOFTWARE. LICENSE HOLDERS ARE SOLELY RESPONSIBLE FOR DETERMINING THE
APPROPRIATENESS OF USE AND ASSUME ALL RISKS ASSOCIATED WITH ITS USE, INCLUDING
BUT NOT LIMITED TO THE RISKS OF PROGRAM ERRORS, DAMAGE TO EQUIPMENT, ANY LOST
PROFITS, BUSINESS INTERRUPTION, LOSS OF DATA OR SOFTWARE PROGRAMS, OR
UNAVAILABILITY OR INTERRUPTION OF OPERATIONS.
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